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Information about Pegasus Mail

Pegasus Mail is an electronic mail system, provided free of charge as a service to the broader community 
of people seeking to benefit from electronic mail: you may use Pegasus Mail on as many systems as you 
wish without cost or obligation. Manuals may be purchased for the program but manual purchases are 
optional - you are under no obligation to purchase a manual.

An overview of the Pegasus Mail system
Getting the software



An overview of the Pegasus Mail system

Pegasus Mail is an electronic mail program that can be used in a very wide range of environments, and 
which is especially well-suited to Internet mail. Individual users with a connection to the Internet via an 
Internet Service Provider such as PSI or Netcom can use Pegasus Mail to send and retrieve mail. 
Pegasus Mail has special support for Novell NetWare local area networks and operates in that 
environment with almost no maintenance and with a number of extra capabilities. In NetWare mode, 
Pegasus Mail can take advantage of a powerful Internet mail transport system called Mercury developed 
by Pegasus Mail's author.

Pegasus Mail is a very comprehensive and powerful system offering a long list of features and 
capabilities, a small selection of which is shown below:

* CC, BCC, Reply-to addressing supported.
* Automatically keep copies of all your outgoing mail
* Support for the Internet IMAP4 remote mailbox access protocol
* Message templates allow you to design your own mail forms
* Message encryption (scrambling) using a very secure algorithm, with the ability to use encryptors 

developed by third parties.
* Up to 64 attachments per message
* Support for all Internet attachment encodings
* Full support for all versions of NetWare MHS
* Comprehensive editor with spelling checker (60,000 words)
* Glossary feature speeds up entry of common text and phrases
* Minimal installation (via simple setup program), and practically no ongoing maintenance
* Mail filtering rules - automate your mail processing.
* Delivery and proof-of-reading confirmation supported.
* Extensive address book features with aliasing.
* Distribution lists allow mailing to hundreds or thousands of users
* Extremely user-configurable with a rich range of preference settings
* Save messages in progress for later retrieval
* Extremely comprehensive context-sensitive online help
* Comprehensive support for the Internet MIME multimedia messaging standard
* Public noticeboards/discussion groups
* Address completion on address fields
* Huge range of sorting and searching options for your mail
* Hierarchical foldering (having mail folders within other mail folders) allows you to organize your mail 

in the way that seems most logical to you.
* Very rich support for the POP3/SMTP Internet mail protocols, allowing you to access your mail with 

any Internet Service Provider using a standard WINSOCK.DLL file like the one supplied with 
Windows 95. Pegasus Mail can access an unlimited number of POP3 mailboxes at an unlimited 
number of sites.

* User-defined gateways - Pegasus Mail lets you design your own mail transport for practically any 
purpose - fax, dialup mail, remote printing and more.

* MailMerge capability allows you to create form letters and fill them out so they look like they have 
been custom-sent.

* Extensions: Pegasus Mail has a very powerful "plug-in" manager allowing developers to create their 
own extra functions that look and behave just like part of the program.

In the Novell NetWare environment, Pegasus Mail also offers the following:

* Excellent support for Novell NetWare local area networks - Pegasus Mail takes full advantage of the 
NetWare environment and has support for both NetWare 3.x and 4.x.

* Extensive supervisor controls on system features
* Direct access to user lists from the NetWare Bindery (or from NetWare Directory Service under 

NetWare 4.1) and (if present) the NetWare MHS directory files.



* Autoforwarding (except when using NetWare MHS)
* Broadcast notification messages announce that new mail has arrived
* List users logged-in to your server and send them messages
* Mail directly to NetWare Groups.



Getting the software

You're reading this, so you've evidently managed to get the Pegasus Mail software from somewhere, but 
for your information, the officially-maintained sources for Pegasus Mail are:

1: By checking our home page, http://www.pmail.com
This site contains all the current versions and lots of useful information.

2: Via anonymous FTP on the Internet:
risc.ua.edu, in /pegasus (North America)
ftp.let.rug.nl, in /pegasus (Europe)
ftp.usm.maine.edu in /pegasus (North America)
pegasus.topnz.co.nz, in /pegasus (South Pacific)

3: Using your Web Browser
http://risc.ua.edu/pegasus    (North America)
http://www.let.rug.nl/pegasus    (Europe)
ftp://ftp.usm.maine.edu/pegasus    (North America)
ftp://pegasus.topnz.co.nz/pegasus    (South Pacific)

4: BBS's
Sorry, can't help you. Pegasus Mail is widely-carried on BBS systems, but no specific 
system is officially supported nor can be relied on to have the most up-to-date versions of 
the program.

You can also obtain the Pegasus Mail software by sending us a self-addressed unstamped envelope and 
US$10 or equivalent (no cheques please) to cover postage and the cost of the diskette. Send to:

Pegasus Mail, c/- David Harris
P.O. Box 5451,
Dunedin,
New Zealand.



Important information about this release.

In the last few months we have seen an upsurge in the use of Pegasus Mail to send bulk unsolicited 
electronic mail. We regard this use as incompatible with the aims and goals of the program, which are to 
improve the quality of communication between people. Accordingly, the terms and conditions of use of 
Pegasus Mail have been modified to incorporate the following paragraphs:

3: The supply or promotion of Pegasus Mail for the purpose of sending bulk, unsolicited e-mail is 
incompatible with the basic aims of the program, which revolve around the free provision of a service 
that enhances the quality of communication between people. Pegasus Mail may not be included in 
any package designed for this purpose, whether free or otherwise, nor may vendors of such 
packages use the "Pegasus Mail" trademark or other related material in the promotion of their 
package. Similarly, we do not consider bulk, unsolicited e-mail to be an appropriate use of Pegasus 
Mail and reserve the right to decline technical support, or the sales of manuals to people using it for 
this purpose.

3a: Prohibited use:    Pegasus Mail may not be used for the purpose of sending Bulk Unsolicited 
Commercial Electronic Mail. For the purposes of this section, this shall be construed to mean 
electronic mail sent to a total of more than 50 recipients for the purpose of advertising a commercial 
product or service, where the recipient has not explicitly expressed interest in receiving such 
advertisements.

Vendors or suppliers currently including Pegasus Mail in their bulk e-mail or mass-mail products are 
hereby required to remove copies of and all references to the Pegasus Mail software from their products.

Known problems in this release

* The <Tab> key will not navigate correctly from control to control in the Options and Preferences dialog 
in the 16-bit version of WinPMail v3.x (this problem does not exist in the 32-bit version). We are looking 
for a solution to this problem in a future release.



A signature is a fragment of text that Pegasus Mail adds automatically to the end of every outgoing 
message you send. Your signature usually contains information describing how to contact you, such as 
your phone number, fax number, e-mail address and so on.

Because some of the information you might put in your signature (especially your e-mail address) is 
defined by the way your message is sent (for instance, your Internet e-mail address is almost always 
different from your MHS address if you use both systems to send mail), Pegasus Mail allows you to define 
signature sets, where each set contains signature information for the three possible ways your message 
could travel - locally, via the Internet, or via MHS. If you only ever use Internet mail then you only have to 
define an Internet mail signature.



Notes applying only to the 32-bit version

If you have downloaded the 32-bit version of WinPMail, then please note the following points about that 
version:

* The Win32 version is intended for use on Windows NT v4.0 or later or on Windows 95/98 systems. It will 
not run on Windows 3.1 systems with Win32S installed, or on Windows NT v3.5x. The 16-bit version of 
WinPMail runs perfectly well in all of these environments.

* If running the Win32 version in NetWare mode, please be aware that it will ONLY work if you are using 
Novell's Client/32 requester: it will NOT work with the Microsoft NetWare requester because of 
incompatibilities between Microsoft's code and the Novell interface libraries used by Pegasus Mail. This 
problem can only be corrected by either Novell or Microsoft - it is outside our control. This restriction does 
NOT apply to the 16-bit version of WinPMail - if you prefer to use Microsoft's NetWare support modules, 
we suggest you use the 16-bit version until either Microsoft or Novell come out with a correction.



Year 2000 Compliance

Pegasus Mail v3.x and its companion server product, Mercury, have been extensively tested to confirm 
that they will cause no difficulties at the turn of the millenium.

For a complete summary of the testing methodology used and the areas examined, please send any mail 
message to faq-y2k@pmail.gen.nz. This will automatically retrieve a document outlining our compliance 
initiative.



Installing Pegasus Mail for Windows

System requirements
Installing the Pegasus Mail files

Connecting Pegasus Mail to an Internet Service Provider

Installing for a single person on a single computer

Installing for multiple people on a single computer
Installing on a network other than Novell NetWare

How to run WinPMail as a specific person

Installing in the Novell NetWare® Environment

Tuning and customising your installation



System requirements

In order to run WinPMail you must have the following:

All implementations:
* A 286 PC or better
* Microsoft Windows 3.1 or later (Windows 95 recommended)
* Minimum 4MB recommended (WinPMail uses about 700K in normal operation, but may use more).
* VGA (640x480) 16-colour display adaptor or better. EGA/Hercules are not supported, nor is Mono 

VGA.

For use in Novell NetWare networks:
* Any version of NetWare later than 2.12.
* A shell version later than 3.26; VLMs recommended.
* NetWare Windows support files properly installed.

For use with Windows Sockets implementations:
* A properly-installed TCP/IP stack
* WINSOCK.DLL compliant with WinSock v1.1 or later.



Installing the Pegasus Mail files

To install the Pegasus Mail program and support files, simply run the Pegasus Mail distribution archive, 
which is a self-extracting installer. The setup program will ask you a couple of very simple questions and 
will then ask you where you would like it to install the system's files. Step by step instructions for getting to 
the point where you can run Setup are at the end of this section. Setup will create a Program Manager 
Group containing the Pegasus Mail program, this file, and the Pegasus Mail online help file. You can run 
Pegasus Mail simply by double-clicking the program icon.

* If you are installing Pegasus Mail for use on a Novell NetWare file server, you should tell Setup to install 
Pegasus Mail into a publicly-accessible directory, although we recommend that you do not install into 
SYS:PUBLIC. Because of the constraints of the DOS and Windows systems, you must give Setup an 
installation path expressed either relative to a drive letter (in DOS format) or else as a UNC path (e.g, \
\SERVER\VOL\PATH), not using the NetWare path format.

* If you are installing Pegasus Mail for use on a local area network other than Novell NetWare, you should 
tell Setup to install the files onto a publicly-accessible volume on your network.

* If you are installing Pegasus Mail on a single machine you can put the program files anywhere.



Connecting Pegasus Mail to an Internet Service Provider

Pegasus Mail can be used to send and receive Internet e-mail via an Internet Service Provider (also 
known as an ISP) using a dial-up connection. It is beyond the scope of this document to advise you on 
selecting an Internet Service Provider -- we assume that you have already selected one and have 
arranged your account.

In order to access the Internet via an ISP, you need to have a file called WINSOCK.DLL installed on your 
computer: your ISP should already have supplied you with this file and instructions on how to set it up.

Before you run Pegasus Mail, you will also need to know the following information, which your ISP should 
also already have given you. If you do not have all the information shown below, contact your ISP's help 
desk and ask them for it. We apologise in advance if there is a certain amount of "compter jargon" in the 
following section - we have tried to word it in such a way that your ISP will know what information to give 
you. Note down the information on a piece of paper and have it handy the first time you run Pegasus Mail.

Your e-mail address
The address other people will use to send you mail.

Your POP3 username, or login name
The name of your account on the ISP's mail host. This is usually simply the text preceding the '@' 

sign in your e-mail address.

Your password
The password that lets you login to your account with the ISP.

The name of your ISP's POP3 mail server
The machine to which Pegasus Mail should connect in order to retrieve your mail.

The name of your ISP's SMTP server
The machine to which Pegasus Mail should connect when sending mail

You will need to supply this information to Pegasus Mail the first time you run it.



Internet Service Provider (or ISP)    an organization that offers connections to the Internet, a world-wide 
computer network linking millions of people. An ISP can provide you with a gateway to the Internet, 
including your own e-mail address, for a small fee each month (around $20 per month is not unusual in 
the USA). You can dial into the ISP at any time to collect your e-mail or access Internet services such as 
the World-Wide-Web. When you are not connected, the ISP's machines accept e-mail on your behalf and 
store it until the next time you log in.



Installing for a single person on a single machine

If your mail needs are such that you will only have a single person running Pegasus Mail on a single 
computer using a single e-mail address, then follow these steps:

1: Run the Setup program following the instructions provided in the section entitled Installing the Pegasus 
Mail files.

2: Double-click the Pegasus Mail icon in the Windows Program Manager or Explorer Group created for 
you by Setup.

3: Pegasus Mail will ask you to select an operating mode - click on the topmost button

4: WinPMail will ask you for a mailbox directory - a place where it should store all your mail-related files. 
Unless you have a good reason for doing so, we recommend that you use the directory name WinPMail 
offers you.

That's all there is to it! If WinPMail can detect a valid WINSOCK.DLL file on your system (WINSOCK.DLL 
is a separate program that allows you to connect to the Internet) it will ask you if you would like to 
configure Pegasus Mail to use it.



Installing for multiple people on a single computer

If any of the following descriptions matches your e-mail needs, you should install Pegasus Mail using the 
instructions in this section:

* You wish to have more than one person reading or sending mail from one computer
* You want to receive mail using multiple e-mail addresses
* You want to keep separate, different configurations for Pegasus Mail (for example, you might want to 

have one version configured with settings appropriate for business use and another configured for 
personal use).

1: Run the Setup program following the instructions provided in the section entitled Installing the Pegasus 
Mail files.

2: Double-click the Pegasus Mail icon in the Windows Program Manager or Explorer Group created for 
you by Setup.

3: Pegasus Mail will ask you to select an operating mode - click on the second button

4: WinPMail will ask you for a mailbox directory - a place where it should store all your mail-related files. 
Unless you have a good reason for doing so, we recommend that you use the directory name WinPMail 
offers you. WinPMail will create a subdirectory in the location you supply for each person who uses the 
program.

5: Pegasus Mail will ask you to enter one or more usernames. Usernames are the tags the program uses 
to identify which files belong to which person on your system. A username can have up to eight 
characters and cannot contain spaces or special characters. As a general rule it's best to use something 
simple, like each person's first name. You can add as many people to the system as you wish, and at 
least one (usually yourself) must be set up as an administrator - a person who can add and remove other 
people from the mail system.

That's all there is to it! If WinPMail can detect a valid WINSOCK.DLL file on your system (WINSOCK.DLL 
is a separate program that allows you to connect to the Internet) it will ask you if you would like to 
configure Pegasus Mail to use it.



Installing on a network other than Novell NetWare

If you have a local area network that is not running Novell NetWare, you can install Pegasus Mail to allow 
the different people on your network to exchange mail with each other by following the steps in this 
section.

1: Run the Setup program following the instructions provided in the section entitled Installing the Pegasus 
Mail files.

2: Double-click the Pegasus Mail icon in the Windows Program Manager or Explorer Group created for 
you by Setup.

3: Pegasus Mail will ask you to select an operating mode - click on the bottom button

4: WinPMail will ask you for a mailbox directory - a place where it should store all your mail-related files. 
You must provide a path to a directory on a shared volume that all your mail users can access. It is 
important that all your mail users see this directory using the same drive letter - you cannot have one user 
see it as drive F: while another sees it as drive G:. WinPMail will create a subdirectory in the location you 
supply for each person who uses the program.

5: Pegasus Mail will ask you to enter one or more usernames. Usernames are the tags the program uses 
to identify which files belong to which person on your system. A username can have up to eight 
characters and cannot contain spaces or special characters. As a general rule it's best to use something 
simple, like each person's first name. You can add as many people to the system as you wish, and at 
least one (usually yourself) must be set up as an administrator - a person who can add and remove other 
people from the mail system.

That's all there is to it! If WinPMail can detect a valid WINSOCK.DLL file on your system (WINSOCK.DLL 
is a separate program that allows you to connect to the Internet) it will ask you if you would like to 
configure Pegasus Mail to use it.



How to run Pegasus Mail as a particular person

When you run Pegasus Mail in a non-NetWare environment, you have to tell it what your username is so 
that it can find your mail files correctly. There are three ways you can do this:

1: Just run the program and it will open a dialog asking you to enter your name.

2: Use the -i <username> switch on the commandline. You can create multiple icons for Pegasus Mail, 
each one invoking the program with a -i switch for a different user. This is probably the most appropriate 
way of handling multiple users on one machine. Note that the i switch cannot be used in NetWare mode 
- for that, you should use the -u switch, which has extra security checks and which forces extra 
authentication information to be written into messages sent during the session.

3: Set a PMUSER environment variable which is set to the name of the user running the program. This 
approach is not very useful in the Windows environment, since you have to exit to DOS to change the 
environment.



Installing Pegasus Mail in the Novell NetWare environment

Pegasus Mail has special support for Novell NetWare Local Area Networks. It is able to make special 
system calls to find out information about other people on the file server and can deliver mail to them 
automatically without further configuration. If you are using Novell NetWare 3.x on your file server, you 
can run Pegasus Mail simply by installing the files and running the program - no further configuration is 
required (NetWare 4.1 requires a little extra configuration). The remainder of this section covers the 
various extra capabilities you can enable for Pegasus Mail in the Novell NetWare environment.

Installing the files under NetWare
Modifying the System Login Script
Selecting a server at runtime ( NetWare 3.x only)
Granting extended features to users
Enabling delivery between servers (NetWare 3.x only)
Configuring Pegasus Mail to use Mercury or Charon
Configuring Pegasus Mail to use NetWare MHS or Connect^2
Feature control using NetWare groups



Installing the files under NetWare

You can use WinPMail's Setup program to install the program on your file server. If you prefer to install 
the files manually, login as SUPERVISOR (or Admin under NetWare 4.1) and follow these steps

To install WinPMail on a Novell NetWare server, copy the files WINPMAIL.EXE, WINPMAIL.HLP, 
WPNNW3.DLL (or WPNNW4.DLL for NetWare 4.1 systems) and WINPMAIL.DAT to a public directory on 
your file server: note that all four must be in the same location. If you want to use the Spelling checker 
option in WinPMail, then you must also place the file PMDICT3.PMD in the same directory or somewhere 
on the DOS path. The files BWCC.DLL and NWCALLS.DLL (and also NWNET.DLL and NWLOCALE.DLL for 
NetWare 4.1) should be placed in one of the following locations:

* Anywhere on the DOS path
* In \WINDOWS\SYSTEM
* In the same directory as WINPMAIL.EXE

If you install WinPMail on the file server, make sure that WINPMAIL.EXE, WINPMAIL.HLP and 
WINPMAIL.DAT are all flagged SHAREABLE - this is very important. WinPMail.exe cannot be flagged 
Execute-only (nor can any Windows application, in fact).

NetWare 3.x: existing users can use the program immediately. There are no extra steps required when 
creating users to allow them to use the system - WinPMail learns all it needs about the user from the 
NetWare Bindery.

NetWare 4.1 in NDS mode: some extra configuration is required to create mailboxes for your users. 
Please consult the file README.NDS in the Pegasus Mail distribution for more detailed instructions on 
the steps required.



Modifying the System Login Script

You should modify SYS:PUBLIC/NET$LOG.DAT, the NetWare system login script, on the host server to 
contain commands similar to the following:

#newmail
if "%ERROR_LEVEL" > "0" then begin

write ""
pause

end

This invokes the Pegasus Mail newmail utility, which reports the number of unread messages the person 
has when logging in. The write statement prints a blank line, while the pause statement gives the person 
a chance to see the message printed by newmail.

Newmail will check for new mail on all servers to which you are attached and logged in. SUPERVISOR-
equivalent users can check for mail for other users on the default server by entering NEWMAIL 
<USERNAME>.



Selecting a server at runtime

[ This section only applies to NetWare 3.x servers ]

If you are connected to more than one NetWare file server when WinPMail runs, it will use whatever is 
your current Default server (the server you were connected to when you turned on your computer).

You can tell WinPMail to use a particular server using a -P command-line option in the group entry you 
create in the program manager. To do this, edit the properties of the WinPMail Program Manager Icon so 
that the run command looks like this:

d:\path\WINPMAIL.EXE -P <SERVER>

Replacing <SERVER> with the name of the server you want WinPMail to use. You must already be 
logged into the    server before running WinPMail - it will not connect you.

You can also change the file server you are using from within the program, using the "File Servers" option 
on the "File" menu.



Granting extended features to users

Some features in Pegasus Mail are only available if the user has been authorised to use them. These are: 
Autoforwarding, mail disable, notification disable, and denial of confirmation-of-reading.

Because granting these rights requires the creation of files or properties using a certain level of privilege, 
they must be explicitly granted by an administrator user (SUPERVISOR or equivalent for NetWare 3.x, 
Admin or equivalent for NetWare 4.x). You can control whether or not a user can subsequently modify 
these settings as well.

To grant extended options to a user, either use PCONFIG, selecting "Grant extended feature rights", or 
else use PMGRANT.EXE, which allows you to use wildcard characters.



Enabling delivery between servers

[ This section only applies to NetWare 3.x servers - when running in NDS mode under NetWare 4.1 
Pegasus Mail can deliver to any user in your NDS tree who has a properly-defined mailbox ]

Pegasus Mail can deliver mail to users on other file servers if access codes are provided. When a user 
attempts to send mail to a user on a remote server, Pegasus Mail searches a Supervisor-defined internal 
table for a usercode and password on the remote server. If one is found, the system uses it to log into the 
remote server and deliver the message. If none is found, the system attempts to log into the remote 
server as the NetWare GUEST usercode, with no password. If all attempts fail, an error is reported to the 
user.

To define the access information Pegasus Mail needs for remote servers, the Supervisor or a Supervisor-
equivalent user should run the pconfig.exe program on the distribution disk. Pconfig presents a menu 
offering `Interface definition' (this option is covered later) and `Server Access definition'. Select the latter, 
and a window will open. If you press <Enter> while the `Add a server' entry is highlighted, another window 
will open prompting you for information about the remote host. 

You should enter the file server's name, and a usercode and password Pegasus Mail can use on that 
server. The data is stored in a heavily- encrypted format which should be secure from even an ardent 
hacker.

You can create any number of entries for remote server access the list will scroll when you have filled the 
window. When you have finished defining servers, press <Ctrl-Enter> to accept the definitions and return 
to the main menu. Choose `Save and Exit' to store the definitions.

The usercode you create for mail access should be extremely limited. I recommend that it NOT be a 
member of group EVERYONE, and that it should have only one explicit trustee right granted to it [C] (or 
[CW] under NetWare 286) rights in SYS:MAIL. Pegasus Mail does not need access to any other directory 
on the host server, nor does it need access to any NetWare utilities.

Pegasus Mail logs into the remote server for the shortest possible time to deliver mail or examine 
usernames, and guarantees that the user will never be left logged-in to the remote host under the mail 
usercode.

Note:    if a mail usercode on a remote server has an expired password, Pegasus Mail will fail when 
delivering the message, even if grace logins are enabled and plentifully available.



Configuring Pegasus Mail to use Mercury or Charon

WinPMail supports the Charon v3 SMTP gateway by Brad Clements of Clarkson University and the 
Mercury Mail Transport System using the same configuration information. To install Pegasus Mail to use 
either of these Internet Message Transports, run the PConfig program supplied and choose SMTP 
Internet Mail Interfaces: a dialog window will appear. You must provide the following information:

Spool interface?    If you are using Mercury 1.11 or later as your SMTP transport agent, you can select 
either a queue or a directory interface to Mercury. The directory interface has some advantages over the 
queue interface and is the only way of running Mercury under NetWare 4.x at this time. For more 
information on using the spool directory interface to Mercury, see the Mercury MGUIDE online guide.

Queue name (or Output path if you are operating in Spool mode)    this is the name of the print queue you 
have created (using the NetWare PConsole utility) or the spool directory from which Charon or Mercury 
expects to retrieve messages. The queue need not exist at the time you define the interface. If you have 
installed Mercury 1.11 or later using the spool directory interface, you should enter the path to the 
Mercury spool directory in this field, preferably in the MS-Net UNC format of \\SERVER\VOLUME\PATH

Use always    enter `Y' if you want WinPMail to use the gateway for all messages, including mail to other 
servers. If you select `N', Pegasus Mail will only pass mail with Internet addresses to the gateway, and will 
use its own mechanism for all other messages.

Server's internet name  Enter here the internet identity you have defined for this file server. Note that this 
is NOT the same as the name of the gateway itself. This address is used to form the sender's address for 
replies. For more information on naming, see the Charon manual or the Mercury MGUIDE online guide. 
The name you enter in this field should be fully domain extended - that is, you should include the domain 
as well as the host name.

Our time zone Type here the UNIX-format abbreviation for your time zone: this is required by the RFC822 
standard for message format. You should enter the time zone as a four-digit value with a leading + or - 
sign to indicate whether you are ahead of Greenwich Mean Time (also known as "UCT") or behind it.
Examples:

If you are 8 hours behind GMT, enter -0800
If you are 12 hours ahead of GMT, enter +1200

When you have filled in all the blanks, accept the data. That's all there is to it!



Feature control using NetWare groups

Many aspects of Pegasus Mail's operation can be controlled using NetWare User Groups (created using 
the NetWare SYSCON or NWADMIN utilities). Pegasus Mail currently recognizes the following NetWare 
groups:

GROUPMAIL Those who MAY send mail to NetWare groups
NOGROUPMAIL Those who may NOT send mail to NetWare groups

MAILBOX Those who MAY have a home mailbox on the server
NOMAILBOX Those who may NOT have a home mailbox on the server

MAILUSERS Those who MAY use Pegasus Mail to send mail
NOMAIL Those who may NOT use Pegasus Mail

PMSEND Those who MAY send one-line messages from <F4>
NOPMSEND Those who may NOT send one-line messages from <F4>

GW_USERS Those who may send Internet mail via Charon/Mercury. 

BECOME Those users who may access another users mailbox

In the absence of both allowing and disallowing groups, the default is that all users have access; so, if 
there is no MAILUSERS and no NOMAIL group, then all users may use mail. The exception to this is the 
BECOME group, which MUST exist before any user can access another
user's mailbox.



Tuning your installation

There are many ways you can tailor the operation of Pegasus Mail to suit the specific needs of your site. 
If you are running Pegasus Mail in NetWare mode, then there are a number of special options only 
available to you - click here to go to the section describing them.

The features described below will work in any type of Pegasus Mail installation

Altering Pegasus Mail's character translation tables
Setting up Noticeboards
Creating files for use by all your mail users
Pegasus Mail in languages other than English
Defining attachment viewers



Altering Pegasus Mail's character translation tables

Because Internet mail is a 7-bit format, you cannot send 8-bit data across it. Accented characters in the 
IBM character set are 8-bit data and must be converted to an alternate format (usually simple ASCII) for 
transmission.

WinPMail has a default translation table for 8-bit data which it applies to messages sent via an Internet 
transport (such as Charon or Mercury). The default table is intended to work with code page 437 and may 
be unsatisfactory in other environments. You can override the default table by creating a resource file 
called WPM-CHAR.RSC in the same directory as WINPMAIL.EXE or in your home mailbox.

A sample WPM-CHAR translation table is provided in the RESOURCE subdirectory of the directory where 
you installed WInPMail, as WPM-CHAR.R. Examine this file for details on how to customise the SMTP 
tables at your site.

WinPMail also supports MIME character encoding using the default ISO-8859-1 character set. You can 
customise the transformations Pegasus Mail does for MIME mail using a WPM-LMTT.RSC resource file - 
again, a sample version of this file is provided as WPMLMTT.R.



Noticeboards

Pegasus Mail supports noticeboards - discussion areas available to designated people, where messages 
can be posted publicly. Noticeboards are accessed by clicking the pinboard icon on the toolbar, or by 
selecting Noticeboards from the file menu. Noticeboards can be used on single computer systems, but 
really come into their own when used in Networked environments.

Setting up noticeboards
To create noticeboards on your system, follow these steps:

* Create a root noticeboard directory somewhere on your file server. In the NetWare environment, the 
default value is SYS:PUBLIC/NB, but it can be anywhere. The only real requirement is that the directory 
be in a directory readable by all the people who need to access noticeboards.

* In this directory, create a file called NB.ID. The file can be empty, although in standalone and non-
NetWare setups it should contain this line:

Administrator: <username>
where <username> is the name of the noticeboard manager.

* Set an environment variable called NB which points to the directory you have set up. The best way to do 
this is to use UNC path notation - for example, \\SERVER\SYS\PUBLIC\NB. You will probably want to 
create this variable in your system login script, or in each user's AUTOEXEC.BAT startup file in non-
NetWare environments.

That's about all it takes. Simple noticeboard administration can be done by administrator users within 
Pegasus Mail for DOS - the Windows version of Pegasus Mail will have similar management facilities in 
due course.

You can control access to noticeboards by altering the rights masks on the directories created under the 
NB location on your server. Manual maintenance of noticeboards can be done by editing the file NB.ID in 
each noticeboard directory. NB.ID is a simple, fairly self-explanatory text file which can be edited using 
any text editor, even (shudder) the DOS EDIT command.

Expiration NLM
A NetWare NLM is available which can handle automatic expiration of messages on noticeboards. Get 
NBEXPIRE.ZIP from the site where you found Pegasus Mail. There is currently no equivalent of this 
program for non-NetWare environments.

Noticeboard management  Manage your noticeboards using the options on the Noticeboard menu within 
Pegasus Mail.



Creating files for use by all your mail users

You may find that you want to have certain Pegasus Mail files which are available to all your users, 
especially address books and mailing, or distribution lists. To create such system-wide files, follow these 
instructions:

Creating system-wide distribution lists
Distribution lists are text files with the extension .PML. To make a distribution list system-wide, copy it into 
the same directory as WINPMAIL.EXE, or else put it in a publicly-accessible location on the server and 
set a DOS environment variable called PML that points to that location (example - SET PML=K:
\WINPMAIL\DLISTS).

Creating system-wide address books
Address books consist of two files - name.PMR and name.PM!, where name is any filename. To create a 
system-wide address book, copy both files for the book into the same directory on the server as 
WINPMAIL.EXE. Alternatively, copy the files into a public directory then set a DOS environment variable 
called PMR which points to that directory. If the address book is large and changes little, consider creating 
a secondary index for it using PMSORT.EXE - this will markedly speed up the process of opening the 
book.

Creating system-wide mail folders
In the same directory on the server as WINPMAIL.EXE, create a subdirectory with the extension .MAI - 
the name is unimportant. In this directory, create a file called PMFOLDER.ID, which contains the long 
name of the folder.

Once you have created the folder and the name file, grant rights to the directory as required: in order to 
read messages, users will need [RF] rights; in order to move messages into the folder, they will need at 
least [RWCF] rights. If you wish to locate your public mail folders in a location other than the directory 
where WINPMAIL.EXE is installed, you can do so by creating a DOS environment variable called MAI 
that points to the proper location.



Pegasus Mail in languages other than English

WinPMail v2 has been designed to be fully translatable into any European language. At the time of 
release, versions for Swedish, German, Danish and French were available and others will become 
available in future. For information on the modules available at any time, mail support@pmail.gen.nz.

Internationalization modules can be found in the authorised download sites. Each module consists of at 
least two files - a DLL and a new .DAT file. To use an internationalization module, copy its files into the 
same directory as WINPMAIL.EXE, then create a DOS environment variable called PMRSC with the two-
letter code of the language you wish to use - so, for example, to use the German version, you would copy 
WINPMDE.DLL, WINPMDE.DAT and WINPMDE.HLP into the WINPMAIL.EXE directory then add the 
DOS command SET PMRSC=DE to your AUTOEXEC.BAT file. Alternatively, you can tell WinPMail to use 
a different language module on the command line via the -X switch - so, once again using German as our 
example, you would add -X DE to the WinPMail commandline.



Attachment viewers

You can define your own set of criteria to determine what program WinPMail can run to view an 
attachment; the usual way of doing this is to use the Attachment viewers option on the Options dialog (on 
the Tools menu), but you can also do this manually by editing a simple text file if you wish.

To define attachment viewers manually, create a text file called VIEWER.PM in either your home mailbox 
location (for personal use) or in the same directory as WINPMAIL.EXE (for system-wide use). You can 
use any editor, even the DOS EDIT command (if you have the stomach for it) to create this file.

Lines in VIEWER.PM starting with ';', '#', '*' or a space are regarded as comments and ignored. Other 
lines define a single viewer, using this syntax:

        <match_type>;<text_to_match>;<extension>;<command_line>

match_type  if 1, then WinPMail should compare the value of the <text_to_match> field with the extension 
from the file's original filename. If 2, then WinPMail should attempt to match the file type information about 
the attachment to the string in <text_to_match>. 

text_to_match  the string WinPMail should use for comparisons when using the test selected via 
match_type. * extension: the file extension WinPMail should add to the temporary file it creates for 
viewing. If you want to use whatever extension is already there, enter a single hyphen on its own (i.e, 
";-;"). This option is useful if you have applications which only recognise files by the extension on the 
filename.

command_line  the commandline WinPMail should pass to Windows to execute the application. The 
name of the file the application should open is added at the end of this string.

Note that white space is significant in these definitions - the only valid delimiter between sections is the ';' 
character. All matches are case-insensitive - so "MS-WORD" and "MS-Word" are treated as the same.

Example:

#  Sample VIEWER.PM file for WinPMail v2.0 and later.
#
#  The first entry tells WinPMail to run LVIEW.EXE any time it
#  sees a file where the original extension was .JPG. Note that
#  you have to include the '.' in the extension.

1;.JPG;.JPG;c:\winapps\lview.exe

#  The next section illustrates a possible use of the extension
#  section: unix systems typically use ".JPEG" for the extension
#  of their JPEG files, but under DOS they are ".JPG".

1;.JPEG;.JPG;c:\winapps\lview.exe

#  The next entry tells WinPMail to run WINWORD.EXE when it
#  encounters any file where the attachment type information is
#  set to "MS-Word". Note the way we force the extension of the
#  file to ".DOC" for Word's benefit.

2;MS-Word;.DOC;c:\winapps\winword\winword.exe



NetWare MHS and Connect^2

Pegasus Mail has full support for all versions of Novell's NetWare MHS mail transport starting with the 
original v1.5 release. This includes support for the following products

NetWare MHS v1.5 (circa 1990)
NetWare Global MHS (also known as NetWare Global Messaging)
Basic MHS (included with NetWare 3.12 and later)
MHS Services (included with NetWare 4.1)

Pegasus Mail also has full support for Connect^2, an MHS-compatible mail system from Infinite 
Technologies Inc.

Installing WinPMail for use with MHS or Connect^2
User-settable MHS options
Installation guidelines for MHS
How Pegasus Mail interacts with MHS



Installing WinPMail for use with MHS or Connect^2

To enable MHS support, run PCONFIG (you must be a SUPERVISOR-equivalent user to do this), and 
choose "NetWare MHS/SMF interface" from the main menu. A window will open, presenting the following 
editable fields:

Enabled: 
If 'Y', this field indicates that MHS mail capability is available on this server. If 'N', WinPMail will generate 
an error message if a user attempts to enter an MHS address.

Preferred:
This flag only has meaning if the Charon SMTP gateway is also installed on the current system. Some 
MHS and SMTP addresses are indistinguishable from each other (canonical MHS addresses are 
ALWAYS correctly sensed): if such an address is detected by Pegasus Mail, it will be routed to whichever 
transport has its "preferred" flag set. If NEITHER transport has its preferred flag set, then the user will be 
asked to use an explicit override (either MHS: for MHS addresses, or IN: for SMTP addresses).

Use always?
If set to 'Y', then all messages will be routed to MHS irrespective of apparent address format. WinPMail 
will rewrite addresses without workgroup parts, using the name defined for this host (so, a message 
addressed to "david" will be rewritten as "david @ hostname"). WinPMail won't use its own local delivery 
agent, and messages to the Charon SMTP gateway (if present) will have to be overridden always (using 
the IN: prefix).

NOTE: Hardened MHS users may instinctively wish to set this field to 'Y', but in general, Pegasus Mail will 
perform better if it is set to 'N', since its own delivery agent is extremely efficient. We recommend that this 
field be set to 'Y' only in an extremely heavy MHS environment - ie, one where a number of MHS mailers 
are used, to the exclusion of all other protocols.

Default workgroup:
This is the name of the local host/workgroup as defined in the installation of MHS on the current server. 
Pegasus Mail uses this name to construct the "From:" field of messages, and when writing addresses to 
MHS format.

Local delivery:
If this flag is set to 'Y', then MHS will be used for any local mail - that is, Pegasus Mail's own delivery 
agent will be disabled. So, where an address such as "DAVID" would usually be taken as a local Pegasus 
Mail address, if this flag is set, then Pegasus Mail will treat it as an MHS address instead. This option 
does NOT cause Pegasus Mail to attempt local MHS delivery without MHS - Pegasus Mail will never do 
this: MHS MUST be running on your system for any MHS delivery to occur.

SMF-71 available?
Set this flag to 'Y' if you are using an SMF-71 transport such as NetWare Global Messaging, or 
Connect^2. Only sites running the original MHS 1.5 release need to set this field to 'N'.

UTC Time value
Enter here the time offset of your area from GMT, expressed as a positive or negative 4-digit value; New 
Zealand, for instance is 12 hours ahead of GMT, so you would enter +1200 here. MHS 1.5 does not 
require this field to be completed.

Use SMFSEND
If set to 'Y', then Pegasus Mail will attempt to use the MHS SMFSEND utility to deliver mail. On some 
systems this will permit mail to be delivered locally without having MHS running, but SMFSEND is not the 
most reliable utility in the world, and performance using this feature may be erratic.

* Note: WinPMail cannot use SMFSEND to deliver mail in any event - only the DOS version of Pegasus 



Mail acts on this field.

DOS MV path
Enter here the path to the MHS tree - exactly the same as the MHS MV environment value set at the DOS 
level. While Pegasus Mail will function correctly if this value is not set, you will not be able to change file 
servers reliably from the Pegasus Mail main menu if it is not.



User-settable MHS options

WinPMail includes a number of user configuration options in its File|Preferences menu:

SMF/MHS user name  if a user has an MHS mail identity which is different from his/her NetWare 
usercode, then he/she will have to enter that identity in this field. The default is the first eight characters of 
the user's NetWare userid. If you are using an SMF-71 transport, such as NetWare Global Messaging, 
then this field can contain a full address, such as "David Harris@Pmail.gen.nz". Pegasus Mail uses this 
value to create the "From" field of outgoing messages.

MHS/SMF mailbox name  each user has a directory in the MHS directory tree where new mail is stored. 
In almost all cases this will have the same name as the first eight characters of the user's NetWare 
username, but very occasionally it might be different. If it IS different, then Pegasus Mail will not be able 
to find new mail for the user until the correct name is entered here.

MHS App name  if a preferred mailer has not been specified for a user when he/she was added to the 
MHS system, then mail will be delivered by default to an MHS application directory called MHS. Normally, 
Pegasus Mail should be installed in your MHS system using the application name PMAIL, which has been 
reserved with Novell: if, however, you are installing Pegasus Mail over the top of an existing MHS mailer, 
you may not wish to alter all the users. In either of the cases described here, you can change the name of 
the application directory Pegasus Mail will scan for new mail by entering its name in this field.

Scan MHS dir for new mail?  If set to Y, then Pegasus Mail will scan the user's default 'MHS' mailer 
directory for new mail, as well as scanning whatever directory is defined in "MHS App name". If Pegasus 
Mail is the only MHS mail application available to a specific person, this field should be set to 'Y'.



Installation guidelines for MHS

The following guidelines can be used to help you decide the best way of configuring Pegasus Mail to 
operate with MHS at your site.

If using Pegasus Mail only, No SMTP, MHS used for external mail
Set "Preferred" to 'N'; "Use always" to 'N'; "Enabled" to 'Y'.

If using MHS and SMTP (Charon) on the same system:
Set "Preferred" to 'Y' if most mail traffic is MHS, otherwise set it to 'N'; "Enabled" to 'Y'; "Use always" to 
'N'.

Heavy MHS sites using more than one MHS mailer, and no SMTP.
Set "Preferred", "Enabled" and "Use always" to 'Y'.



How Pegasus Mail interacts with MHS

WinPMail understands three different message formats: RFC-822, the Internet mail format; MHS SMF-70, 
the format of MHS 1.5, and SMF-71, the format of NetWare Global Messaging and MHS v2. It can 
distinguish between the message formats transparently: WinPMail's own mail agent uses the RFC-822 
format. WinPMail stores all new mail in the user's unique mail directory in SYS:MAIL, irrespective of the 
transport used: if new MHS messages are detected in MV/.../USERS/APPNAME, they are moved to the 
user's SYS:MAIL directory before being read, along with any associated attachments. After being read, 
messages may migrate to a user-specified home mailbox (perhaps on a local drive) or may be left in 
SYS:MAIL/USERID, depending on user configuration.

Outgoing mail is ALWAYS placed in MV/MHS/MAIL/SND for routing via MHS, as per the recommendation 
in the "MHS 1.5 Technical Overview". WinPMail will NOT attempt local MHS delivery on its own - the MHS 
Connectivity Manager must be running for mail to be delivered. Since the expected main use of Pegasus 
Mail is in sites where its own agent is used for local delivery, and MHS is used for off-site transport, this 
should present no problems.

Local delivery:    Pegasus Mail will NEVER attempt to perform local MHS delivery - the MHS Connectivity 
Manager must be run. The only possible exception to this is to use SMFSEND for local delivery, but this 
option has variable reliability.

MHS Macros, as defined in the "Technical Summary of MHS 1.5" are not supported, will NOT be copied 
back into replies if referenced, but will not generate errors.

Confirmation requests: MHS requests for confirmation of receipt are honoured: confirmation is generated 
at the moment the message is opened for reading.



Updating from an older version

If you are already using an earlier version of WinPMail, you can upgrade to the new version in either of 
two ways:

1: Run the Setup program supplied with WinPMail and when it asks you where you would like to install 
the software, give it the name of the directory where your old version is located. Setup will replace only 
the program and support files and will not affect your existing mailbox or its contents. When you use this 
upgrade method, the new version of WinPMail will automatically be able to locate your mailbox and its 
contents.

2: Run the Setup program supplied with WinPMail and when it asks you where you would like to install 
the software, give it a new directory name. This will cause it to create a freshly-installed version of 
Pegasus Mail without touching your existing version, but the new version will not automatically be able to 
locate your existing mail files. In order to enable the new version to find your mailbox you can do one of 
two things - either copy the file PMAIL.CFG from the current version's directory into the new version's 
directory, or else run WinPMail and when it asks you for mailbox information, give it the same values you 
used for the existing version.

The advantage of the second upgrade method is that it allows you to run both the new and old versions of 
Pegasus Mail in parallel until you are comfortable with the new version. In general, though, we 
recommend that you use method 1 because it is simpler and because there is seldom an reason to revert 
to the old version of the program.



Internet mail via WINSOCK.DLL

WINSOCK, or Windows Sockets, is an open specification allowing applications to access TCP/IP 
networking services from any compliant implementation. Most modern TCP/IP suites for Windows will 
include WINSOCK.DLL, the file providing these services.

Pegasus Mail for Windows can use WINSOCK.DLL to perform direct TCP/IP-based electronic mail using 
the SMTP and POP3 protocols. If you have a PC attached to a TCP/IP-based network, WinPMail's 
WINSOCK-based mail services may be of use to you. They can be used simultaneously with any 
connection you might have to a NetWare server, but do not require a NetWare connection.

WINSOCK-based mail support is configured using the Network Configuration option on the "File" menu. 
This menu option will only appear if a valid WINSOCK.DLL is available on your system.

Recommended implementations
Installation considerations
Preventing WinPMail from using Windows Sockets
Notes when using WinSock-based mail
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Recommended implementations

Almost all competent TCP/IP implementations for Windows will include WINSOCK.DLL, but the following 
stacks have been more widely-tested with WinPMail than most:

* LAN Workplace for DOS v4.1 or later, from Novell, Inc.
* The Trumpet Winsock, by Peter Tattam.
* Microsoft WinSock, supplied with Windows 95 and Windows NT

WinPMail should, however, work with any properly-implemented WINSOCK implementation.



Installation notes

WinPMail requires no particular installation to use WINSOCK services on your system, except that the 
WINSOCK.DLL must be in one of the following locations:

* The same directory as WINPMAIL.EXE
* In the \WINDOWS directory
* In the \WINDOWS\SYSTEM directory
* Anywhere else along the DOS PATH

WinPMail needs to be able to see the actual WINSOCK.DLL file in order to use it - it cannot currently 
detect a WINSOCK.DLL which has already been loaded into memory. WinPMail will use the first 
WINSOCK.DLL it can find by searching the locations shown above in the order shown.



Preventing WinPMail from using Windows Sockets

If you do not want WinPMail to load WINSOCK.DLL, you can prevent it from doing so using any of the 
following means:

* Set If WINSOCK.DLL is available, load it to NEVER in your Advanced Settings preferences (under 
the File menu).

* Change the command line you use to run WINPMAIL.EXE so that it reads 
WINPMAIL -Z 1

*  Before running Windows, set a DOS environment variable like this:
SET WINPMAIL=1

* Removing WINSOCK.DLL from your path.



Notes when using WinSock-based mail

* Mail is queued until sent - an indicator in the WinPMail status line shows the number of queued 
messages. Send queued mail by choosing "Send queued mail" from the file menu.

* For security reasons, Pegasus Mail will only send SMTP mail if it can first perform a POP3 login to 
the account you have specified in your Network Configuration screen. The POP3 address is written 
into a "Comments" field in mail you send as a validation of who you really are.

* Background checking for new mail is configured in the Network Configuration screen. If using a SLIP 
line or any other slow line you may want to disable periodic checking by setting the idle check time to 
0 and disabling checks while the application is minimized.

* SLIP and PPP lines: if using WinPMail and WINSOCK over SLIP (Serial Line IP) or PPP (Point to 
Point Protocol), you will almost certainly have to set a longer timeout value in the network 
configuration screen. 60 seconds should be adequate for almost all scenarios.



Extensions for Pegasus Mail

WinPMail v2.1 and later support a powerful concept called Extensions,.(other systems also variously call 
these Plug-ins, Snap-ins or Add-ons) Using Extensions, you can add almost any imaginable service or 
feature to WinPMail.    Each extension can appear in a standard WinPMail window and looks just like part 
of the application.

Extensions are Windows DLLs that are hosted inside WinPMail. They can be loaded in a variety of ways, 
and as well as having access to the full Windows programming set, have access to an Application 
Programmer's Interface (or API) of over 80 special functions provided by WinPMail itself. The API set 
includes functions for accessing preferences, generating messages, full TCP/IP protocol support, logging 
functions and more.

Anyone who has done simple Windows development should be able to produce WinPMail Extensions 
without great difficulty.

Using the sample extensions provided with Pegasus Mail
Obtaining the Extension Development Kit
Developing Extensions
Finding out about new Extensions



Using the sample extensions

WinPMail 2.5 includes six sample extensions -- if you used the WinPMail setup program, these 
extensions will have been installed for you automatically. The sample extensions provided with WinPMail 
are:

PHONE A telephone message form
PH A directory service module using the PH protocol
FINGER Lookup unix users via the FINGER protocol
MAILMERGE A sophisticated mass-mailing program
MultiPOP Allows you to access multiple POP3 accounts
WLDAPA directory service module for the LDAP protocol

These extensions are supplied ready-to-run: to use them, simply select them from the Extensions 
submenu of the Tools menu. Most of them have their own online help systems.

Full source code for most of these extensions is provided as part of the Extension Development Kit, which 
is available from the authorised download sites.



Obtaining the Extension Development Kit

Anyone interested in developing extensions for Pegasus Mail should get the Extension Development Kit, 
which contains all the necessary information and header files, as well as source code for most of the 
sample extensions provided with Pegasus Mail. The Extension Development Kit is free software, just like 
Pegasus Mail itself and may be freely used by anyone. You should be able to find it as WPMFORMS.ZIP 
at the site from which you downloaded your copy of Pegasus Mail, or from the official download sites.

Extensions developed using the Extension Development Kit are royalty-free and may be distributed in any 
manner the developer wishes, including sale.



Developing WinPMail Extensions

The process of developing an extension for WinPMail involves some Windows programming, but because 
Pegasus Mail does most of the work for you, it is considerably easier than writing the same application 
from scratch.

What you'll need to develop an Extension
Obtaining the Extension Development Kit
Getting started
Documentation for Extension Developers
Authenticating and registering new Extensions
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What you'll need to develop an Extension

In order to develop a WinPMail extension, you will need a Windows development environment capable of 
generating a standard Windows DLL file - this is the only specific requirement. I personally use and like 
the Borland C compiler (I prefer v3.1 to v4.5) but you can use any suitable tool.

You probably cannot use a pseudo-language such as Visual Basic because WinPMail expects to find one 
specific C-callable routine in your DLL for initialization purposes.

You should be familiar with the way Windows passes messages, since you "call" WinPMail's Extension 
Manager by sending messages to it. The file WPMFORMS.H in the FORMS subdirectory of your 
WinPMail installation directory contains a complete reference to the format and parameters of the 
messages you can send.

If your extension needs a user interface, you will also have to be familiar with managing simple Windows 
dialogs: WinPMail handles all the messy aspects of the Multiple Document Interface (MDI) for you, so all 
you have to do is manage your own dialog.



Getting Started

The easiest way to write an extension is to take one of the sample extensions provided with Pegasus Mail 
and use it as a model. Your extension will need to have the standard Windows DLL format, with a LibMain 
function which registers any classes it uses. Note that if you create a dialog interface in your extension, it 
must by definition be a modeless dialog (that is, it must have a class and a specific message handling 
function).

From WinPMail's perspective, every instance of an extension is tied to an MDI (Multiple Document 
Interface) window; information about the extension is stored as part of that window, and if the extension 
contains a dialog, that dialog will be a child of the MDI window. If an extension needs to access an 
internal WinPMail service, it simply sends a message to the MDI window to which it is attached. Similarly, 
WinPMail will occasionally need to send messages advising the extension about events in the system; 
when it needs to do this, it will send the message to the extension's dialog window, or if it doesn't have 
one, to an optional function which the extension can export which takes the same parameters.

The exact form your extension will take is up to you; the API WinPMail exports to extensions is extremely 
rich and I am sure people will come up with uses for it which I can't even begin to predict. The mechanics 
of your DLL will depend on the function it is to fulfil, but I recommend the following settings as a good 
starting point:

Memory model: Large
Call format: All-calls exportable
Target version: Windows v3.1

Note that because WinPMail only runs in Standard or Enhanced mode Windows, you don't have to worry 
about the hideous complications of memory allocation under Real mode - just call "malloc" or whatever 
the way you always have.



Documentation for Extension Developers

WinPMail's Extension Manager interface is documented in the files WPMFORMS.H and WPMFORMS.TXT 
which you will find in the Extensions Development Kit.

If you are a beginner to Windows programming and are looking for a book to get you started, I 
recommend Charles Petzold's book Programming Windows version 3.1, published by Microsoft Press.

If you have a basic grasp of Windows programming but would like a more specialised tutorial guide, I 
recommend Windows 3: A Developer's Guide by Jeffrey Richter, published by M&T Books.

Finally, a book I believe every Windows programmer should have is The Windows Programming Puzzle 
Book, by Kim Crouse, from John Wiley & Sons Inc; this book is a Godsend for those subtle questions the 
official documentation doesn't cover.

Disclaimer: Pegasus Mail's author has no association with any of the authors or publishers shown above - 
this list merely represents a list of titles the author has personally found valuable.



Authenticating new Extensions

Because extensions are distributed as working, executable machine code, many sites may be reluctant to 
use an extension when they are unaware of its pedigree. If you have an extension you think would be 
useful and would like to see it widely distributed to the Pegasus Mail user community in a verified, secure 
manner, then you can follow these steps:

* Debug and test your extension thoroughly until you are sure it works. This step is very important! The 
author does not provide a debugging service for your extensions and will reject out-of-hand anything 
which does not compile correctly or which crashes when run.

* Contact the author of Pegasus Mail, David Harris, at the Internet e-mail address 
David.Harris@pmail.gen.nz. He will arrange for you to upload a private copy of your extension to his 
system and will examine it for certification.

* You MUST upload source code to your extension. The author will only certify extensions which he 
has personally compiled, and when distributing them will only distribute binary versions which he has 
built. You are not required to distribute the source code with the extension itself, but it must be made 
available to him. Note, though, that you are strongly encouraged to make the source code for your 
extension available if you can.

* If your extension checks out OK and builds correctly, it will be made available on the principal 
Pegasus Mail distribution sites and endorsed as "safe and authenticated" by the author.

* For technical reasons, the author can only certify extensions which are written for Borland C++ 
version 3.1 or later. Please make sure you include the appropriate make, PRJ or IDE file, as well as 
all associated RC, H and C or CPP files.

The Author is willing to sign non-disclosure agreements with Extension Developers.

Reserving extension tag names:

Because extensions need to define tags for themselves which can be used to invoke a reader extension 
on receipt, it is obviously desirable to ensure that tagnames remain unique. In order to encourage this, 
the author offers a free tagname registration service. Send a mail message to 
tagnames@pmail.gen.nz indicating the tagname(s) you would like to reserve and optionally a brief 
description of your extension (for the author's interest). Tagnames will be registered on a first-come/ first-
served basis, and if a tagname you have requested is already taken, you will be advised as soon as 
possible. The author reserves the right to refuse to register tagnames for any reasons he deems fit - for 
example, tagnames containing obscene words will not be accepted, nor will any tagname starting with the 
letters "PM", because all such tagnames are reserved by the author. The list of currently- registered 
extension tagnames can be retrieved by e-mail at any time by sending a message to 
maiser@pmail.gen.nz consisting of the two lines:

SEND TAGNAMES.TXT
EXIT

Please note that tagnames can be a maximum of 12 characters long, may not contain characters with 
ASCII values lower than 33 or higher than 126 and are case-insensitive. All form names starting with the 
letters "PM" are reserved for Pegasus Mail use.



Finding out about new Extensions

Pegasus Mail's author provides an authentication service for Extensions to WinPMail (see in the 
"Developing Extensions" section for details of registering an extension). If you find an extension and are 
uncertain of its pedigree, you can check it out by sending a message to maiser@pmail.gen.nz which 
contains the two lines:

SEND VALIDXTN.TXT
EXIT

The mail server will respond by sending you the list of registered extensions: these are extensions which 
have been checked, compiled and certified by Pegasus Mail's author. VALIDXTN.TXT also tells you 
where to find the certified versions (that is, versions which have been built and authenticated by Pegasus 
Mail's author). If you obtain a certified version of an extension, you can be certain that is virus-free and 
safe to use.



Technical support and Mailing lists

Technical support for Pegasus Mail is available by sending Internet e-mail to support@pmail.gen.nz. This 
will retrieve an automatic response which describes how to obtain FAQ lists covering a wide range of 
topics concerning Pegasus Mail. It will also tell you how to get in touch with various mailing lists and news 
groups covering Pegasus Mail.

If you have purchased a license for Pegasus Mail manuals, then you are entitled to technical support 
directly from us: to request technical support, send a message to:

tech-support@pmail.gen.nz

NOTE: When requesting technical support, you MUST show your manual license number (shown on the 
invoice and on the license) in the subject line of your message. While we try to answer all technical 
support requests sent to us by licensees, sometimes our workload may not permit it: if you do not receive 
an answer to a message sent to our tech support account, the answer may be contained in the FAQ lists, 
or we may be overloaded. If you cannot find an answer in the FAQ lists, wait 24 hours then mail us again.

Please note that the staff at Pegasus Mail Central process in excess of 250 mail messages every day and 
accordingly, where possible, we ask that you consult the FAQ lists and mailing lists before contacting us 
directly.

Other sources of information:

The PMAIL mailing list and related lists
The PM-NEWS announcement list

Click here to return to the contents page



The PMAIL mailing list

The PMAIL mailing list provides a forum where discussion and assistance for Pegasus Mail matters is 
available. It is operated by the University of Alabama in Tuscaloosa - my sincere thanks to James Ford 
and the Administration of the University for making the service available. The list is quite busy, but is an 
excellent source for solutions to most problems arising in general use of Pegasus Mail.

You can subscribe to this mailing list by sending a message to listserv@bama.ua.edu (note: from 
CompuServe, use the address >internet:listserv@bama.ua.edu) with the message body set to:

SUBSCRIBE PMAIL firstname lastname

Example: your name is Jose Bloggs - you would send:

SUBSCRIBE PMAIL Jose Bloggs

Send discussion to pmail@bama.ua.edu. Please note that the discussion address and the subscription 
addresses are not the same. You can only mail to this discussion list if you are a subscriber.

Related lists

The following related lists also exist at this site, each one providing coverage for a single version of 
Pegasus Mail.

PM-WIN Discussion about the Windows version
PM-DOS Discussion about the DOS version
PM-MAC Discussion about the Macintosh version
MERCURY Discussion about the Mercury Mail Transport System

You can subscribe to these lists exactly the same way as you would subscribe to the main PMAIL list, 
except using the name of the list in the SUBSCRIBE line instead of PMAIL. Mail sent to any of these 
specialised lists is automatically distributed to the main PMAIL list as well.



The PM-NEWS announcement list

The PM-NEWS announcement list is a mailing list operated by the University of Alabama in Tuscaloosa, 
providing low-volume notification of new releases and important announcements. The list is moderated, 
which means that only the list owner can send messages to the list, but anyone can subscribe to it.

If all you want is to be told about new releases of Pegasus Mail and related products, then this list is the 
one for you -- on average, this list only generates one or two messages each month and is guaranteed 
spam-free.

You can subscribe to this mailing list by sending a message to listserv@bama.ua.edu (note: from 
CompuServe, use the address >internet:listserv@bama.ua.edu) with the message body set to:

SUBSCRIBE PM-NEWS firstname lastname

Example: your name is Jose Bloggs - you would send:

SUBSCRIBE PM-NEWS Jose Bloggs

If you have information you want posted to the PM-NEWS list,send it to PMNEWS@bama.ua.edu: your 
message will be referred to the list moderator, who will decided whether or not it should be distributed to 
the wider list membership.



Spam -- apart from being an English brand of canned beef, a spam is a particularly odious practice 
whereby an advertising message is sent to thousands of mailing lists and news groups indiscriminately, 
resulting in a huge waste of Internet resources and considerable nuisance value for millions of people 
who usually have no imaginable interest in the product being advertised. We consider spamming to be a 
completely inappropriate use of Pegasus Mail.



FAQ Lists -- Freqently-Asked Question lists. These are compilations of the questions most commonly 
asked on the regular technical support channels and are always a useful starting point for finding 
solutions to problems quickly.



Terms and conditions of use

Pegasus Mail is free software and may be used by any number of users on any number of systems 
without fee or obligation, subject only to the terms and conditions laid out below.

Pegasus Mail is NOT in the public domain - the author, David Harris, retains ownership and copyright, 
and exclusively reserves all rights to the software. In countries where assertion of the right to be identified 
as the author is required for copyright purposes, David Harris asserts his right to be recognized as the 
author and owner of the Pegasus Mail System and all its associated components.

Modification of the program or its resources or associated data files without the author's explicit written 
permission is strictly forbidden. Unauthorised modifications of any component of the Pegasus Mail 
System are a breach of intellectual property laws in most countries and will be pursued vigorously to the 
full extent of the law.

Pegasus Mail may be used by anyone and may be freely distributed via any medium, either commercial 
or non-commercial, provided the following conditions are met:

1: Distribution    The Pegasus Mail Software must be distributed complete and unaltered in the 
original self-extracting archive, with all messages intact. System administrators and ISPs wishing 
to repackage the WinPMail archive for supply to their users may do so provided some basic 
guidelines are followed - please send e-mail to tech-support@pmail.gen.nz for more information 
on this. In the event that the Pegasus Mail software is being distributed as part of another 
package or software bundle, or in association with software or services for which a charge is 
being levied, the author's permission must be obtained before distribution occurs. We will 
authorise by fax or by an e-mail message signed with our public key signature at our discretion. 
Bona fide Internet Service Providers are exempted from the requirement to obtain formal 
permission (see section 5, below).

2: Charging for distribution    No charge may be directly levied for Pegasus Mail itself. Fair copying 
and support charges may be applied but you must not represent that you are actually selling the 
software itself. The intent of this statement is to allow book publishers to distribute the system 
freely with books, and to permit Software Libraries and BBS systems to distribute Pegasus Mail in 
their catalogues provided only reasonable handling and duplication fees are charged.

3: Prohibited supply    The supply or promotion of Pegasus Mail for the purpose of sending bulk, 
unsolicited e-mail is incompatible with the basic aims of the program, which revolve around the 
free provision of a service that enhances the quality of communication between people. Pegasus 
Mail may not be included in any package designed for sending bulk unsolicited e-mail, whether 
free or otherwise, nor may vendors of such packages use the "Pegasus Mail" trademark or other 
related material in the promotion of their package.

3a: Prohibited use:    Pegasus Mail may not be used for the purpose of sending Bulk Unsolicited 
Commercial Electronic Mail. For the purposes of this section, this shall be construed to mean 
electronic mail sent to a total of more than 50 recipients for the purpose of advertising a 
commercial product or service, where the recipient has not explicitly expressed interest in 
receiving such advertisements.

4: Ownership    Ownership of the Pegasus Mail Software remains vested in the author, David Harris. 
You may not represent ownership or copyright in the system in the course of distribution, and you 
must not represent any specific connection with, or authorisation or license from the author.

5: Distribution by ISPs    Bona-fide Internet Service Providers are explicitly granted permission to 
bundle the Pegasus Mail Software with their standard subscriber access package if they wish, 
even if a charge is levied for that access package, provided the conditions laid out in section (1) 
above are met. If you supply Pegasus Mail as a separate item (as opposed to being part of an 



access bundle), you may only charge a reasonable duplication or handling fee and must 
otherwise abide by all other terms and conditions defined herein.

6: No liability    although all possible care has been taken to ensure that the Pegasus Mail Software 
is as reliable as possible, the diversity of environments in which it might be used means that we 
can accept no responsibility for loss or damage, whether real or consequential, arising from its 
use. By using the software you explicitly agree to hold the author blameless for any such losses 
or damages.

7: All rights reserved    we reserve the right to change the terms and conditions of use and 
distribution of Pegasus Mail without specific notice, although we will make reasonable efforts to 
advise of any such change through normal channels (user groups, mailing lists and so on). The 
current terms and conditions of use of Pegasus Mail can be obtained at any time by sending a 
message to tech-support@pmail.gen.nz requesting them.

All the legalese aside, it is my strong desire that Pegasus Mail be as widely used as is possible in the 
hope that by furthering communication between people, we may in some small way come to understand 
and accept each other better.

Click here to return to the contents page



User-defined gateways

A User-defined gateway is a program or set of programs that Pegasus Mail can use to send or receive 
mail. They can be used to provide access to message systems not normally supported by Pegasus Mail, 
such as Fax systems or Pagers, and are also used to make Pegasus Mail work in environments where it 
usually would not, such as when using uucp to send Internet mail.

WinPMail supports user-defined gateways, but with some limitations compared with Pegasus Mail/DOS.

* Validation routines defined for gateways will not work.

* Gateways that require a program to be run will work, but you may have to fiddle with the Windows icon 
unless you can run the program from a PIF file.

* There is no equivalent of PM-MENU.RSC in WinPMail to allow you to add items to the menus at this 
stage.

For full information about user-defined gateways, please obtain the file UDG.ZIP from any of the 
authorised download sites; alternatively, UDG.ZIP is included with Pegasus Mail for DOS, which is also 
available from the same locations..



Troubleshooting

At some stage, things will probably go wrong -- there's no escape from Murphy's Law. This section lists 
the most common problems and solutions known to us at the time of release of this version of the 
program. See the next section, Technical support for information on how to obtain the most up-to-date 
lists of common problems and solutions.

READ THIS FIRST!!!
WinPMail and the Novell NetWare environment
WinPMail and Windows 95
WinPMail and WINSOCK.DLL
"Cannot create container file" errors
International character set problems
Other problems



Murphy's Law:    "Anything that can go wrong, will go wrong".
There's also Parkinson's Law -- "Work expands to exceed available time".

Forget Einstein -- these are the laws that REALLY govern the universe.



First steps for troubleshooting

It has been our repeated experience that the vast majority of problems people have with WinPMail fall 
into three categories, none of them actually to do with the program itself:

1: Configuration problems    more than 80% of all problems reported to us result from simple 
misconfiguration of the system. Pegasus Mail doesn't require a great deal of configuration, but it is 
important that the configuration it does require be done correctly. Always read this file (WGUIDE.HLP) 
carefully, especially the "Important information" and Installing WinPMail" sections.

2: Problems with other people's software    this is particularly true with WINSOCK.DLL, because the 
quality of available WINSOCK implementations varies widely. If your problem results in a GPF (Windows-
speak for a crash), check the report Windows generates carefully - it will say something like "WINPMAIL 
caused a GPF in module XXXXXX"; the actual cuplrit is whatever is named in XXXXXX: if it is the name 
of a DLL, especially WINSOCK.DLL, then your problem almost certainly is not in WinPMail but in a third-
party product.

3: System problems    some very common problems can be caused by incorrectly installed network 
drivers, by marginal hardware (this is especially true of modems), or by running in environments with too 
little disk space or memory. In the network environment, incorrect or inadequate trustee and access rights 
can also cause innumerable problems. Always check these external influences before assuming that 
WinPMail itself is at fault.

Finally, if WinPMail is producing an error message, please read it carefully! Very often, the solution to the 
problem will be shown in the message itself.



WinPMail and the Novell NetWare environment

How can I stop WinPMail from running in "NetWare mode"?
You can force WinPMail to run in standalone mode (ie, to ignore the connection to the NetWare server) by 
changing the command line you use to run the program to:

WINPMAIL -A
This commandline switch also works for the DOS version of Pegasus Mail.

WinPMail tells me it can't find my home mailbox, but it's there!
There are three possible causes for this problem:
[*] 1: You may be running Windows in Standard mode while connected to a NetWare server, and your PC 
is using the Novell NETX shell set. This combination will provoke a bug in the NetWare API libraries, 
especially if your machine is a 286. The only solution is to move to the VLM shell set or to step back to 
WinPMail 1.02 (which uses an older API set).
[*] 2: If you are running in standalone mode (not connected to a NetWare server), your standalone 
configuration might be incorrect - the most likely cause is an invalid path in either the home mailbox or 
new mailbox fields in PCONFIG. Try deleting the file PMAIL.CFG in the directory where WINPMAIL.EXE 
is located and re-entering the values the next time WinPMail starts up.
[*] 3: You may be running under NetWare 4.0x in a directory services context which is not the Bindery 
Context. WinPMail is a Bindery-based NetWare application and requires information from the NetWare 
Bindery, which is poorly emulated under NetWare 4.0x. The only solution is to have your usercode moved 
into the Bindery Context.

WinPMail runs in standalone mode even though I'm connected to a NetWare server
Windows reports "Cannot find NETWARE.DLL" when starting WinPMail
You probably have not installed NetWare support into your copy of Windows. Run the Windows setup 
program and see what Network it thinks you are using; if it says "None", choose "Novell NetWare" and 
insert the disks it asks for. You should also make sure you are using the most recent NetWare drivers 
from Novell - at the time of writing these are contained in the files WINDR2.EXE, VLMUP3.EXE, 
NET33X.EXE and NWDLL2.EXE, available via FTP from ftp.novell.com in /novlib/novfiles, or in the 
NOVUSER area on CompuServe. The "Cannot find NETWARE.DLL" message is an error in Windows - 
there is no "NETWARE.DLL" - it is looking for NETWARE.DRV.

Windows, The "Black Screen of Death" and broadcast messages
If your copy of Windows crashes with the "Black Screen of Death", or your system locks up or behaves 
erratically when you receive the broadcast "New mail" notification messages Pegasus Mail generates, 
then you almost certainly have a NetWare Shell problem. Make sure you are using the absolute most 
recent driver files from Novell (see the preceding entry for details on getting these) and take particular 
care to delete all old versions of these files (especially NWPOPUP.EXE and NETWARE.DRV) right across 
your DOS path.



WinPMail and Windows 95

I'm running Windows 95 and getting GPFs in NWCALLS.DLL
There is a bug in Windows 95's NetWare emulation such that it reports a server connection even when 
there is none actually available. You can fix this easily by forcing WinPMail to start in standalone mode by 
adding the switch "-A" to its command line.

My Windows 95 users can't send mail via Mercury - it gets returned with a "missing $$ signature" 
diagnostic.
There appears to be a severe bug in the Windows 95 NetWare Queue Services emulator which means 
that the first four bytes of jobs written directly to queues by programs will be corrupt. The only workaround 
I have been able to find for this is to switch Mercury and WinPMail into Mercury's spooler submission 
mode instead of queue mode. This problem may also affect Windows NT v3.51 users, because that 
system appears to use the same Queue Services code with the same bug.

I'm trying to use the Microsoft WINSOCK.DLL supplied with Windows 95 but am having connection 
problems.
This, and variants of it, are usually attributable to having WINSOCK.DLL files other than the Microsoft 
version on your system. This is particularly likely to happen if you have upgraded to Windows 95 rather 
than doing a fresh install. Hunt through your system making sure that there is only one copy of 
WINSOCK.DLL present and that it is the Microsoft offering.



WinPMail and WINSOCK.DLL

The quality of WINSOCK implementations currently available for Windows seems to be extremely 
variable, so if you have problems with WINSOCK- based mail in WinPMail, please check first that you 
have the current version of your WINSOCK.DLL and any support software, and that it's correctly 
configured.Next, if you are getting connection problems, try expressing the address of the host to which 
you want to connect using dotted IP notation instead of an address (or vice-versa).

Many problems using WINSOCK across slow SLIP or PPP links arise from timeouts being set too short - 
set a much longer timeout value in your network configuration screen in these cases (I recommend up to 
120 seconds).

WinPMail v2.0 and later uses "non-blocking sockets" to obtain the greatest level of control of TCP/IP 
communications. Some WinSock implementations do not handle non-blocking sockets well. If your 
WinSock implementation has problems connecting with WinPMail, or if performance is erratic, try 
changing the command line you use to run WinPMail to:

WINPMAIL -Z 1024
This will force WinPMail to use blocking sockets, at the price of lower performance and possibly 
occasional conflicts between POP3/SMTP and TCP/IP-aware WinPMail extensions.

I don't get the Network Configuration or other WinSock-based entries on the File menu
[*] WinPMail may be unable to find WINSOCK.DLL - make sure it is on the path, in \WINDOWS, or in 
\WINDOWS\SYSTEM. On some systems, especially Windows NT, you may find you have to force 
WinPMail to "Blind load" WINSOCK.DLL -- you do this by changing the command line you use to run 
WinPMail to:

WINPMAIL -Z 128
[*] You may have the Winsock loading field in your Advanced settings preferences dialog in WinPMail set 
to Never. Set it to On demand or Always then exit and restart the program.

WinPMail reports "Invalid password" when I connect to my POP3 server, but I've double-checked and the 
password is right.
[*] The password may be right, but your username may not be (for security reasons, most POP3 servers 
will accept any username and fail the password automatically if the username is invalid). The most 
common cause of this is putting a full address in the "username" field of the Network Configuration 
dialog's POP3 section. If you can see an '@' symbol in this field, then it's wrong - WinPMail only wants 
your basic username, which is everything preceding the '@' in your address.

I'm trying to use the Microsoft WINSOCK.DLL supplied with Windows 95 but am having connection 
problems.
This, and variants of it, are usually attributable to having WINSOCK.DLL files other than the Microsoft 
version on your system. This is particularly likely to happen if you have upgraded to Windows 95 rather 
than doing a fresh install. Hunt through your system making sure that there is only one copy of 
WINSOCK.DLL present and that it is the Microsoft offering.

I'm trying to use the 32-bit Microsoft WINSOCK.DLL supplied with Windows 95 but it won't autodial when 
WinPMail loads it..
This appears to be a problem in the 32-bit WINSOCK.DLL itself - as far as we have been able to 
determine, the 32-bit version will not autodial if loaded by a 16-bit application such as Pegasus Mail. At 
the time of release we are taking this issue up with Microsoft.

How can I prevent WinPMail from autoloading WINSOCK.DLL?
WinPMail has built-in support for a variety of e-mail protocols using the TCP/IP networking protocol. To 
provide this support, it looks for a file called WINSOCK.DLL when it starts up; WINSOCK.DLL is a file 
supplied by your TCP/IP vendor which provides a standard interface to TCP/IP network services for 
Windows programs. If you do not want WinPMail to load this file (and hence not to provide access to its 



built-in mail TCP/IP mail services), do one of the following:
[*] Prior to running Windows, enter the command "SET WINPMAIL=1" from the DOS prompt. You cannot 
do this from a Windows DOS session - you must do it prior to running Windows
[*] Change the command line the Program Manager uses to run WinPMail so that it includes the switch "-
Z 1". You can use this switch with all other switches in the program.
[*] Go to the Advanced settings preferences dialog in WinPMail and set the Winsock Loading field to 
Never.



"Container file" errors and what they mean

One of the most common errors you may see from WinPMail is a message saying:

      WinPMail has failed creating the container file for a message

This is also one of the harder error messages to diagnose, but in general it means that Pegasus Mail has 
attempted to create a file for delivery and the operating system has reported a failure on the operation. 
The most common causes for this problem are:

[*] (In NetWare mode) This message can indicate several things:
* You may be out of disk space on the file server volume where the recipient's mailbox is located (or the 
submission directory if you are sending mail via Mercury)
* You may have insufficient rights in the destination directory
* The destination directory may not exist (this can happen on NetWare 4.x servers running in Bindery 
Emulation mode when the recipient has never logged into the server, because NetWare 4.x only creates 
the user's SYS:MAIL mailbox when he or she logs in the first time).
* If sending mail between servers, this may indicate an error in the configuration of the inter-server 
delivery account created for Pegasus Mail's use, usually a password or connection restriction, or a lack of 
rights in the destination server's SYS:MAIL directory.

[*] (In standalone mode) You may have addressed the message to a local user who does not exist. 
Because Pegasus Mail can manage multiple users on the same machine, if you enter an address like 
"david", or "betty" - namely, an address with no domain portion - Pegasus Mail will assume it refers to a 
user on your own machine and will try to deliver it locally. If you have no users other than yourself on your 
machine, you may want to set the "Use for all outgoing mail" flag in the Network configuration dialog - this 
tells Pegasus Mail that there are no local users and to send everything via the SMTP transport.



International character set problems

Pegasus Mail users in countries where English is not the primary language will often run into problems 
using accented characters in electronic mail. Problems with accented characters are not a sign of 
ignorance or carelessness on the part of Pegasus Mail's developer (who studied French for 11 years and 
German for 5) -- rather, they reflect a very general problem with computers in that there is very little 
standardisation on character sets and the way they are represented.

The first thing to do to improve the situation is to turn on Pegasus Mail's MIME support - MIME goes a 
long way towards dealing with International character set issues. Enable MIME support by checking the 
control in the Special view of the message editor.

You can customize the character sets Pegasus Mail uses for MIME messages by creating and compiling 
a file called WPM-LMTT.RSC, and placing it in the same directory as WINPMAIL.EXE. A sample source 
file for this resource, called WPM-LMTT.R, is supplied in the RESOURCE\ subdirectory of the directory 
where you installed WINPMAIL.EXE - examine it for details of the formatting required.

For non-MIME messages it is impossible to preserve 8-bit data accurately in any meaningful way -- when 
sending non-MIME mail, Pegasus Mail will always convert accented characters to non-accented ASCII 
equivalents; this process is required by the Internet mail standard, RFC822, and cannot be subverted. 
You can customise the conversion process Pegasus Mail applies to your accented characters by 
providing a WPM-CHAR.RSC file in the same directory as WINPMAIL.EXE. As with WPM-LMTT.RSC, 
this file is compiled from source you provide, and a sample WPM-CHAR.R file is provided in the same 
location.



MIME (Multi-purpose Internet Mail Extensions)
MIME is an Internet standard for the transmission of data of any type via electronic mail. It defines the 
way messages should be formatted and constructed and has provision for indicating the type and nature 
of the contents of a message, and for preserving international character set information. In most cases, a 
MIME message can be read correctly on any kind of system which has a MIME-compliant mail program.

MIME provides direct support for graphic images in GIF and JPEG format, Video images in MPEG format, 
and Audio data as well. It also has a Digest format for sending multiple mail messages at once (Pegasus 
Mail displays MIME digests in a manner very similar to a folder).

Pegasus Mail will automatically handle incoming MIME messages without any intervention from you. The 
decision over whether it should generate outgoing messages in MIME format is yours -- to enable MIME 
features, click the control in the Special view of the message editor. Once checked, the setting will be 
remembered for all subsequent messages. The only reason you would not use MIME formatting for 
Internet mail would be if you knew your correspondent did not have access to a MIME-compliant system.

MIME is described in the Internet Standards Document RFC1521.



Other problems

The .WAV file I have chosen as a new mail alert sound doesn't work
By default, the new mail alert sound only works when WinPMail is minimized on your desktop.
[*] If you would prefer the alert sound to play any time new mail arrives, add the switch "-Z 512" to the 
WinPMail command line

I have some users whose preferences don't get saved properly between WinPMail sessions
WinPMail only saves your preferences when it believes they have changed during the session - 
sometimes it may fail to detect changes.
[*] You can force WinPMail to save your preferences by holding down the Ctrl key while selecting "Exit" 
from the file menu.
[*] This can also happen when user has no rights to read or write files in the temporary directory specified 
in the TEMP or TMP environment variable, or in the "Temporary files directory" setting in the user's 
PMAIL.INI configuration file.

Why can't I see some of/all the mail folders I created using older versions of Pegasus Mail?
WinPMail supports hierarchical foldering using "trays", or containers in which folders can be placed. 
When it first runs, WinPMail creates a file called MAIN.PMT which is your main tray and contains all the 
folders it can find in your home mailbox: from this point, it uses the file to maintain your hierarchy. If you 
create a folder using an earlier version of Pegasus Mail after you have run this version, the new folder will 
not be added to the hierarchy file and WinPMail will not be able to see it.
[*] Solution: run WinPMail, and press <^L> to select a folder; choose "Check tray list"from the Folders 
menu. This instructs WinPMail to look for any folders which might be missing from your hierarchy and add 
them to it.

How can I stop WinPMail from running in "NetWare mode"?
You can force WinPMail to run in standalone mode (ie, to ignore the connection to the NetWare server) by 
changing the command line you use to run the program to "WINPMAIL -A". This commandline switch also 
works for the DOS version of Pegasus Mail.

Why do all my folders and other mail files appear twice in WinPMail?
If you can see two entries for each DList, Folder, Addressbook or other WinPMail file when you try to 
select one, and one is in blue, then you have probably installed WINPMAIL.EXE in the same directory as 
your home mailbox (as opposed to using the recommended installation); this causes WinPMail to see 
every file as both personal and system-wide, and to list them twice.
[*] Solution: Move WINPMAIL.EXE, WINPMAIL.DAT, WPNNW3.DLL (if you are
on a NetWare system) PMAIL.CFG (if you are running on a standalone system) and WINPMAIL.HLP into 
another directory.

My new mail folder doesn't open at startup even though I have the option checked in my preferences.
WinPMail originates from the LAN world and is still far and away most heavily used there; in that 
environment, most users prefer to have the new mail folder open automatically only if there is actually 
new mail to display. This option is less useful for standalone users so a fix is provided.
[*] Solution: Add the switch "-Z 256" to the WinPMail command line(in the Program Manager Icon you 
created for it). This will force the new mail folder to open irrespective of its contents.



Technical support, manuals

Your first port of call for technical support for Pegasus Mail is the Pegasus Mail online help and this help 
file. The answers to most questions can probably be found in these two files, especially in the 
Troubleshooting section on the WinPMail help menu.

If these resources don't turn up the answer for you, send a mail message to the Internet address 
support@pmail.gen.nz. This will retrieve an automatic reply listing all the available sources of help, 
including regularly-updated frequently-asked-question lists (FAQs), and addresses for Pegasus Mail-
related mailing lists. 

Printed manuals are available for Pegasus Mail at very reasonable prices. We don't guarantee you'll find 
the answer to every problem in the manual, but it is a handy, complete reference to the program, and 
purchasing manuals gives you access to direct e-mail technical support from us. Manual purchases are 
totally optional - there is no pressure or obligation for you to purchase manuals: for more information on 
ordering manuals, click here.

If you have purchased a license for Pegasus Mail manuals, then you are entitled to technical support 
directly from us: to request technical support, send a message to:

tech-support@pmail.gen.nz

NOTE: When requesting technical support, you MUST show your manual license number (shown on the 
invoice and on the license) in the subject line of your message. While we try to answer all technical 
support requests sent to us by licensees, sometimes our workload may not permit it: if you do not receive 
an answer to a message sent to our tech support account, the answer may be contained in the FAQ lists, 
or we may be overloaded. If you cannot find an answer in the FAQ lists, wait 24 hours then mail us again.



Pegasus Mail Manuals

Although fully-copyrighted and the property of the author, David Harris, Pegasus Mail is distributed as free 
software, provided as a service to the broader Internet community. Anyone, whether business, school, 
government or individual may use the Pegasus Mail software on any number of machines without charge 
or obligation and it may be freely distributed provided it is supplied complete and unmodified, and that 
only reasonable handling charges are made for the supply.

Nonetheless, the process of developing and maintaining a system as large and complex as Pegasus Mail 
has definite costs that have to be met: in order to cover these costs, the author sells manuals for the 
Pegasus Mail System. We wish to stress that manual purchases are optional. There is no pressure or 
requirement that you purchase a manual set -- if you are happy running the program without a manual, 
then we regard that as a compliment.

Purchasing any manual license gains you direct access to our technical support engineers if you have 
problems. Once you have received your manual and license, you can send queries to tech-
support@pmail.gen.nz, making sure you quote your license number in the subject line, and we will assist 
you to the extent permitted by our workload.

Manuals for Individual Users
Manuals for Multiple Users
Internet Service Providers
Charitable and Environmental Groups



Manuals for individual users

Single-User manuals are provided as a soft-bound User Guide of about 90 A4 pages with a short 
appendix covering issues specific to setup and operation in the standalone (i.e, non-networked) 
environment. The manual is accompanied by a CD-ROM containing all current versions of our software. 
You may not duplicate a Single-User manual, and it does not include the Network Administrator's Guide 
for the program. Purchasing a single-user manual license gains you direct access to our technical support 
engineers if you have problems.

Single-User manuals cost US$39.95 or the equivalent in your currency (see the next section) plus the 
cost of whichever freight method you choose.

Terms and conditions
Order form



Single user manuals, terms and conditions

We have attempted to keep the price of the Single-User manual set as low as possible, but in order to do 
so, we have had to apply a few ordering restrictions (which do NOT apply to multi-user licenses): 

1: We cannot accept company purchase orders for Single-User manuals unless you are purchasing 5 or 
more copies (in which case you should look at Multi-User licensing in the previous section before placing 
your order). Please note: "company purchase order" in this context means an official, payment-on-invoice 
order form.

2: We require payment with order, either by credit card or cheque. We will accept cheques in any 
currency negotiable in New Zealand, provided the cheque is drawn on a bank in the country where that 
currency is used (so, we cannot accept a cheque in US Dollars drawn on a Canadian bank, for instance). 
The cheque you send us must have a value equivalent to or greater than the US$ amount of the order; 
we recommend you ask your bank for an exchange rate. At the time of writing, we know for sure that we 
can accept payment in: US Dollars, Canadian Dollars, Deutschmarks, French and Swiss Francs, English 
Pounds, Italian Lira, Swedish or Danish Kronor, Dutch Guilders, and Australian and New Zealand Dollars.

3: We will accept payment in cash in any of the currencies above, but you must add a US$5 (or 
equivalent) surcharge to cover our bank's conversion charge. We STRONGLY urge you NOT to pay by 
cash unless there is no other way, and if you MUST do so, make sure you send it by registered mail.

4: Orders must be sent to us on the order form which follows this section. We cannot accept orders sent 
using any other form.

5: If you are a US corporation or any other US body which is required to perform tax reporting on 
payments it makes, be advised that the vendor is not US-resident for tax purposes and cannot supply you 
with FEINs, SSNs or any other US Tax-related data. Requests for this information will not receive replies.

6: No future upgrades to either the documentation or software are included in the price of a Single-User 
manual, but purchasing a manual will entitle you to a small discount on any future copies you buy.

7: Although we undertake to get your manuals out to you as quickly as we can, there is a basic 10-14 day 
processing delay on all orders we receive -- this delay should be added to the delivery time for your 
chosen shipping method to determine a likely delivery date.

8: Purchasing a single-user manual license entitles you to contact our technical support engineers directly 
if you have problems. While we try to answer all queries sent to us for tech support, we reserve the right 
to defer questions if they are adequately covered in the FAQs or in the manual itself, or if we are 
abnormally busy (in the latter case, you will usually receive an automated message asking you to try 
again later). To obtain technical support, you must include your manual license number in the subject line 
of your message, which should be sent to tech-support@pmail.gen.nz.



Pegasus Mail Single-User Manuals, Order Form

This order form is valid until March 1st 2001 and applies only to single-user manuals. Before 
completing and submitting this order, please ensure you have read the terms and conditions.

Ship to:
[ ] Please write or type clearly,
[ ] making sure you include your
[ ] postal code (if any) and your
[ ] Country. All orders must be
[ ] clearly signed.

Date this order was mailed [          ] Day    [          ] Mon    [          ] Year
Payment is enclosed (tick if so)
      or: Credit card type (tick one)  Visa

 Mastercard
Card number (print carefully) [ ] exp: [            ]
Name shown on card [ ]

Internet e-mail address of contact [ ]
Fax number of contact [ ]

Signature accepting terms [ ]

Please supply:
[          ] Copies of the Single-User manual set for Pegasus

Mail for Windows @ US$39.95 each (or equivalent) US$ [ ]

Shipping: please select a shipping method (mark with a tick)
 NEW ZEALAND ONLY Domestic airmail @ US$2.50 US$ [ ]
 By surface mail, @ US$6.50/copy (20-30 days) US$ [ ]
 By first-class airmail, @ US$10/copy (7-14 days) US$ [ ]
 By EMS or TNT courier, @ US$24/copy (3-5 days) US$ [ ]

All shipping times exclude a basic 7-12 day order processing period.

Order total including freight, in US dollars US$ [ ]

 NEW ZEALAND CUSTOMERS ONLY: add 12.5% GST [ ]

Grand total (enclose cheque or credit card details) US$ [ ]

w302
Please airmail your order and payment to

Pegasus Mail, c/- David Harris
P.O. Box 5451,
Dunedin,
New Zealand.

or if paying by credit card, you can fax it to us on +64 3 453 6612.



Manuals for multiple users

Overview of Multi-User manual licenses
How to order manual sets
Discounts and upgrades
Payment by credit card
Payment by telegraphic transfer
Fees deductions, orders from Europe
Terms and conditions applying to orders
Freight costs

Order form for multi-user manuals



Freight costs for shipping manuals

Manuals are shipped via courier to any location in the world. The delivery time is usually 3-4 days and is 
fully traced. Freight costs are as follows:

When ordering one multi-user manual, add:
To Australia and New Zealand US$15.00
To the U.S.A. and Canada US$27.50
To the U.K. and Europe US$32.50
All other destinations US$37.50

When ordering two or more multi-user manuals, or any Bundle option, add:
To Australia and New Zealand US$20.00
To the U.S.A. and Canada US$34.00
To the U.K. and Europe US$39.00
All other destinations US$45.00

Examples:
* Shipping a WinPMail site license to Sydney, Australia, add US$15
* Shipping a DOS and Windows bundle to Cincinatti, U.S.A, add US$34
* Shipping four WinPMail 10-copy manuals to Germany, add US$39.00



Overview of Multi-User manual licenses

Multi-User manuals are provided as a single loose-leaf document ready for copying; the license supplied 
with the manual permits you to make a certain number of duplicates of the original. The quality of the 
manual is high. All manual orders are shipped with a CD-ROM containing the most recent versions of all 
our software. The manuals are shrink-wrapped, and you may request either A4 (European) or US-Letter 
(North American) paper format. Purchasing a    manual license gains you direct access to our technical 
support engineers if you have problems.

Two levels of Multi-User manual license are available:

10-user manuals  you get one printed manual with a license to make up to 10 further copies. This costs 
US$195.

Site-licensed manuals  you get one printed manual with a license to make as many copies as you wish for 
one site. One site is defined as the extent of any organization in any one city or town, so if you have two 
branches in the same town, one site license will cover both of them. As well as the manual, site licensees 
get a diskette with RTF and ASCII versions of the manual. Site licenses cost US$375.

Shipping is via courier (usually a three day service to anywhere in the world) and shipping costs are extra: 
freight costs can be calculated using the freight table.

A number of "bundle" options are also available which allow you to get manuals for more than one version 
of Pegasus Mail at reduced prices - please see the order form for more details.

A 10-copy manual can be upgraded to a full site license at any time by paying the current difference in 
cost between the two.



How to order manual sets

To order Pegasus Mail manuals, please fill out the order form in this guide (also available as an ASCII file 
called ORDER.FRM supplied with the distribution) and return it by mail or fax with your purchase order, 
cheque or credit card details to:

Pegasus Mail, c/- David Harris,
P.O. Box 5451,
Dunedin,
New Zealand.

Fax: +64 3 453 6612

We do not use postal codes in New Zealand.

*** If you fax your order to us, please DO NOT send the original by mail as confirmation.

Please be sure that you actually complete and enclose our order form - we will use it as the final authority 
for shipping and billing addresses, since many organizational purchase orders have ambiguous 
addressing details.

We are happy to accept organizational purchase orders provided payment is made on normal credit terms 
(nett 30 days).

Payment must be made in US dollars, drawn on a US bank.unless special arrangements are made with 
us in advance. There is usually a delay of around 2 weeks before a manual can be sent out, and we 
reserve the right to hold your order if a new release is pending (so you can get the new release). Manuals 
are always sent by Express Mail Service or TNT courier (2-4 day delivery anywhere in the world); freight 
fees are extra and are added to the invoice total; freight costs can be calculated using the freight table.

PLEASE, PLEASE! Remember to enclose the order form: we're not psychic, and we can't guess at 
delivery addresses from a cheque alone...



Payment by credit card

We can accept payment for Manual orders on any valid VISA or Mastercard. If you wish to pay this way, 
please note your card number, expiry date, and the name on the card on the order form, then sign the 
order form (signing the form is VERY IMPORTANT - we cannot process your order if you do not sign).

We cannot accept American Express or Diners Club, sorry.

Special Conditions:

* The amount you are billed will probably not be exactly the amount on the order, because I have to 
submit the voucher to the VISA Centre converted to New Zealand dollars. I will use the USD conversion 
rate which applies on the day your order is processed.



Discounts and upgrades

If you already hold a license for any version of Pegasus Mail, then two discount options may be available 
to you:

1: If you want to upgrade your existing documentation to the current version for the same system, you can 
use the "Upgrades" section on the order form. Upgrading a license this way costs US$135. You can only 
upgrade the same system to a more recent version using this option (e.g., DOS to DOS, Windows to 
Windows, but NOT DOS to Windows). You can upgrade either 10-copy or site licenses using this option - 
the licensing level on the upgraded manual set is the same as for the original set.

2: If you hold a site license for one version (e.g, the DOS version) and you want to purchase a site 
licensed manual for a different version (e.g, the Mac or Windows version), then you can claim a $75 
discount on the price. So, for example, if you hold a site licensed manual set for the DOS version, you 
can claim a $75 discount on the Windows and/or Mac version site licenses.

IMPORTANT NOTE!! This discount only applies to purchases of site licenses, and only if you already 
hold a site license. You cannot claim this discount for purchases of 10-copy licenses, bundles, or 
upgrades (as in section 1 above).



Payment by telegraphic transfer

We will accept payment by telegraphic transfer, but you should be aware that this is one of the most 
expensive and troublesome ways of paying an invoice because of serious flaws in the International 
Banking system.

When paying by telegraphic transfer, you must add US$15 to the total invoice amount to cover bank 
charges in transit. If you do not add this surcharge and fees are deducted from the amount in transit, our 
bank has standing instructions to return your payment to you unaccepted, which will almost certainly 
result in extra fees being deducted from the amount returned to you.

Transfer to: 
The National Bank of New Zealand,
Dunedin North Branch,
Dunedin, New Zealand,
Account 060-909-0106632-13
The account name is "David Harris Pegasus Mail".

Please make sure that your bank states my invoice number in the transfer narration, so we can credit the 
remittance correctly against your invoice in our records.



Fees deductions, orders from Europe

A note to European users:    it appears to be common practice for European Banks, particularly in 
Germany, to deduct fees from the cheque they send. In some cases, these fees have been as high as 
US$25.

Because of the costs of manual production, and the relatively small amounts involved in the invoice, 
deductions of fees from remittances cannot be accepted!! If your bank deducts fees from the 
remittance you make, I will return the cheque unpresented for repayment. If you prefer to make payments 
via direct credit to a bank account, please see the preceding section on "Telegraphic Transfers" or else 
contact me for details.

We understand that in some European countries it can be very difficult to make international payments. 
We would like to assist you where we can, so if you would prefer to make your payment by an alternative 
method, we will try to oblige you - please contact us by fax or e-mail before doing so to arrange this.

Fax: +64 3 453 6612
E-mail: orders@pmail.gen.nz



Terms and conditions applying to orders

The following terms and conditions apply to all orders for Pegasus Mail manual sets. Submitting an order 
indicates acceptance of these terms and conditions in their entirety, over and above any waivers, 
disclaimers or conditions stated on the order itself.

Terms and Conditions

Orders    All orders must be submitted on our order form (see below, or ORDER.FRM in the Pegasus Mail 
archive); you should attach your company or organization purchase order as well if applicable. Orders 
MUST be signed to accept our terms and conditions.

Site    For licensing purposes, a "site" is the extent of a single organization in a single Metropolitan area; 
so, a University with three campuses in the same town would be covered by a single site license, but a 
government department with offices in four separate cities would require four licenses. For the purposes 
of this definition, State, National and Municipal Governments do not qualify as "organizations", nor do 
"umbrella" institutions, such as a Board of Education covering all high schools in a city.

Special licensing arrangements  We are quite flexible about manual licensing and will gladly consider 
proposals for special-case scenarios.    We also like to try to help charitable and environmental 
organizations where we can. If you would like to discuss special-case licensing, please send Internet e-
mail to David.Harris@pmail.gen.nz.

Organizational purchase orders and payment  we are happy to accept organizational purchase orders 
provided that our invoice is paid under normal credit terms (nett 30 days). We can also accept payment 
by VISA or Mastercard - in order to do so, we need the card number, expiry date, the name exactly as 
shown on the card, and a clear signature on our order form. Credit card payments may not appear as an 
exact amount on your statement because we have to submit our vouchers converted to NZ dollars - we 
use the exchange rate prevailing on the processing date. If paying by credit card, please ensure that the 
details on your order form are typed, not written and ensure that our order is signed. We will accept 
payment by International Money Transfer (also called "Telegraphic Transfer"), but please read the next 
section carefully before doing this.

Payment by IMT (International Money Transfer)  we are willing to accept payment by money transfer on 
payment of a US$15 surcharge, but recommend that you avoid this method of payment because of 
serious flaws in the international banking system. Please use the following details:
      National Bank of New Zealand, Dunedin North Branch, account 060909-0106632-13.
      The name of the account is "David Harris, Pegasus Mail".
VERY IMPORTANT: In order to cover processing fees imposed on us by the banks, you must add 
US$15 to your remittance when paying by IMT. Failure to do this will result in the remittance being 
returned to you unaccepted, probably with hefty fees deducted by the banks.

Currency  all prices are shown in US dollars; we require payment in US Dollars drawn on a US Bank. The 
exception to this is for clients in New Zealand, who are welcome to contact us for a New Zealand Dollar 
rate. Please note the "US Bank" requirement carefully - payments in US Dollars drawn on non-US banks 
attract considerable fees at this end and will be returned unpresented.

Invoices  all manual purchases are properly invoiced. New Zealand clients will receive a valid Tax Invoice 
(prices are inclusive of GST in New Zealand).

Fees and deductions  it appears to be common practice in parts of Europe for banks to deduct fees from 
the amount remitted - we will not accept such deductions and will return payments from which fees have 
been deducted unpresented. We require the amount paid to us to be the amount shown on the invoice.

Withholding taxes    We will not accept any payment from which a withholding tax deduction has been 
made unless that deduction is made according to the taxation laws of New Zealand. Withholding tax 



regulations in countries other than New Zealand are a matter between you and your government and are 
nothing to do with us.

US Taxpayer information requests  we periodically receive requests from US companies and 
organizations asking us to provide "FEIN" numbers, or Social Security Numbers, which are needed by the 
client for compliance with US Tax Laws. We have contacted the US Commerce Attaché in Sydney, 
Australia, and advise on their recommendation that the vendor is NOT a US Citizen, and is not resident in 
the USA for taxation purposes. We cannot provide the information requested (we have neither a FEIN nor 
an SSN) and requests for such information will not receive a reply. We suggest you record that the vendor 
is a foreign national not subject to US taxation laws. FORM W8 - Please note that form W8 is only 
applicable to foreign nationals carrying on a charging activity within the United States - we do not have an 
obligation to complete this form, nor is it appropriate for us to do so.

Quotes, bids, pro-forma invoices and acknowledgments  because of the sheer volume of paperwork we 
have to process, we regret that we are unable to provide quotes, bids, pro-forma invoices or 
acknowledgments of receipt of orders (other than by e-mail on specific request). The most recent version 
of our order form retrieved from us by e-mail may be taken as a firm quote - we will honour the prices 
shown provided this form is used.

VAT and import taxes  when we ship manuals, we enclose a commercial invoice for customs purposes, 
itemized as US$11 for materials and the remainder of the fee as a license charge. We are not responsible 
for taxes or import duties levied on entry to your country and suggest you contact your customs service in 
advance for information on any fees which might be payable. This is of particular importance for people 
ordering from England - HM Customs pursue VAT aggressively even though we believe they may be 
attempting to charge it in error (our understanding is that license fees are not subject to VAT).

Freight charges  Manuals are always shipped via courier shipment anywhere in the world, and the freight 
cost is extra. Courier service usually provides four-day delivery to any destination. We can ship via airmail 
on specific request, but are unable to ship via specific carriers (such as FedEx, UPS or DHL). Freight 
prices can be calculated using the freight table.

Delivery times    the usual processing time for an order is 8-10 days plus the time required for shipment. 
Occasionally the time required will be longer than this, and if a new version of the manual is due in the 
near future, we reserve the right to hold your order until it is released, so that you get the most up-to-date 
product.



Please read Terms and conditions carefully before signing and sending this form.
       ------------------------------------------------------
                G E N E R A L   O R D E R   F O R M
        for Pegasus Mail Manuals, valid until March 1st 2001
       ----------------------------------------------w312c---
 Ship To:                            Bill To:
[                            ]      [                                ]
[                            ]      [                                ]
[                            ]      [                                ]
[                            ]      [                                ]
[                            ]      [                                ]

Date this order was mailed          [   ] Day  [   ] Mon  [   ] Year
What is your purchase order number  [                                ]
 or: Credit card type (tick one)    [   ] Visa [   ] Mastercard
     Card number (print clearly)    [                    ] exp: [    ]
     Name shown on card             [                                ]
Number of invoice copies required   [   ]
Manual format required (tick one)   [   ] A4   [   ] US-Letter
Internet e-mail address of contact  [                                ]
Fax number of contact               [                                ]

Authorised signature accepting terms and conditions: [               ]

--- New Manual Licenses: --------------------------------
[  ] 10-copy manual set, Pegasus Mail/DOS @US$195. . . . US$ [       ]
[  ] 10-copy manual set, Pegasus Mail/Windows @US$195. . US$ [       ]
[  ] 10-copy manual set, Pegasus Mail/Mac @US$175. . . . US$ [       ]
[  ] Single manual set, Mercury System @US$150 . . . . . US$ [       ]

[  ] Site-licensed set, Pegasus Mail/DOS @US$375 . . . . US$ [       ]
[  ] Site-licensed set, Pegasus Mail/Windows @US$375 . . US$ [       ]
[  ] Site-licensed set, Pegasus Mail/Mac @US$325 . . . . US$ [       ]
[  ] Site-licensed set, Mercury System @US$300 . . . . . US$ [       ]

[  ] Site bundle, Pegasus Mail/DOS and WinPMail @US$550  US$ [       ]
[  ] Site bundle, Pegasus Mail/DOS and Mac @US$525 . . . US$ [       ]
[  ] Site bundle, Pegasus Mail/Mac and WinPMail @US$525  US$ [       ]

[  ] Site bundle, DOS, Windows & Mac @US$775 . . . . . . US$ [       ]

--- Upgrades (please quote current license number) ------
Any previous DOS license to current version @US$135  . . US$ [       ]
Any previous Mac license to current version @US$135  . . US$ [       ]
Any previous Windows license to current version @US$135  US$ [       ]
Any previous Mercury license to current version @US$135  US$ [       ]

--- Freight (shipping via TNT courier) ------------------
Freight cost calculated using freight list               US$ [       ]

---------- Discounts: -----------------------------------
If you order or hold a SITE license for one Pegasus Mail
platform (DOS, Win, Mac) you can claim $75 off each sub-
sequent SITE license platform purchase (EXCLUDES BUNDLES).
                            Total discount . . . . . . . US$ [       ]

(NOTE: discounts do NOT apply if you hold a 10-copy license,
or are purchasing a 10-copy license, upgrade or site bundle)



Manual licensing for Internet Service Providers

Internet Service Providers are granted explicit permission to include the Pegasus Mail software with their 
subscription kits, even if they charge for those subscription kits. We have comprehensive customization 
and configuration routines and services available to ISPs and Network Administrators - for more 
information, please contact us at tech-support@pmail.gen.nz.

For Internet Service Providers who wish to include a pre-licensed Pegasus Mail manual set with their 
subscription kits, special bulk rates may be negotiated with Pegasus Mail's author. You can either 
purchase pre-printed manuals in bulk at discounted rates, or alternatively, you can negotiate very cost-
effective production licenses, where you produce the manuals yourself and pay a royalty to the author.

For more information on ISP manual licensing, please contact Pegasus Mail's author directly by sending 
e-mail to David.Harris@pmail.gen.nz.



Manuals for Charitable and Environmental Groups

The author regards Pegasus Mail as a service in support of a set of ideals that might seem prosaic or 
incomprehensible to some people. Be this as it may, the author is also happy to offer support and 
assistance where he can to other people and groups who are attempting to work for the general good.

If you represent a charitable organization, or a non-profit organization devoted to Environmental Issues, 
then you may qualify for free or subsidised manual sets. We will also gladly consider any request for free 
or subsidised manual sets if genuine hardship can be shown.

If you would like to discuss this possibility further, please contact Pegasus Mail's author directly by 
sending mail to David.Harris@pmail.gen.nz.



What's new in v3.x?
Pegasus Mail v3.x is the most major upgrade of the program since its inception, and is just loaded with 
new features, capabilities and fixes. Below is a list showing the most important additions in v3.x - click on 
any line to get a more detailed description of the new item.

New in WinPMail v3.12c
* Many, many bug fixes.
V3.12c is the last in the v3 family of Pegasus Mail for Windows. The next release will be v4.

New in WinPMail v3.12b
* Bug fixes only

New in WinPMail v3.12a
*    Powerful new   Select   option for complex selection within folders  
*    Telltale (new mail reporting) has been totally redesigned
*    New system messages window offers extra information
*    Filtering rules now support a logical AND operator
*    A new filtering rule action allows you to mark messages as "significant"
*    Support for sending mail using Authenticated SMTP
*    Several changes and improvements have been made to templates
*    Many, many small bug fixes and corrections

New in WinPMail v3.10
*    Full support for the IMAP4 protocol
*    Address completion
*    Message Templates (user-programmable forms)
*    "Resend" option for your copies to self
*    You can now "attach" an identity to any folder
*    You can now "attach" filtering rules to any folder
*    The spelling checker has been improved
*    Mounted mailboxes are now remembered between sessions
*    Many corrections and cosmetic changes

New in WinPMail v3.01d
*    Bug fixes only.

New in WinPMail v3.01c
*    New option to check all identities for POP3 mail
*    Noticeboard administration built-in, noticeboards heavily reworked
*    Inline display of several graphic types
*    PH directory service module redesigned
*    Attachments can now be deleted from Multipart MIME messages
*    Word wrapping enhanced for reading mail
*    HTML handling considerably improved
*    New identity options for editor, filtering rules and commandline
*    Significant performance improvements in MIME handling
*    Various minor goodies
*    Lots and lots and lots of bug fixes

New in WinPMail v3.01b
*    New editor technology allows formatting and unlimited size
*    User-interface appearance heavily overhauled to be more "standard"
*    Right-click menu options in most major window types
*    Filtering rules heavily overhauled and improved
*    New plugin foldering model supports Unix mailbox files
*    Hierarchical foldering completely reworked



*    Circulation messages for distributing documents
*    Spelling checker improved, new dictionary
*    "Identity" support heavily improved and built-in
*    Simultaneous access to multiple mailboxes
*    Easier POP3/SMTP setup, new capabilities, dialling
*    Mail queue and Message draft management reworked
*    Folders, sorting and display
*    Reading mail, HTML, RTF, Annotations
*    New options for sending mail
*    Lists, selection, and the Intellimouse
*    Configurable toolbar, and toolbar options
*    Features specific to Windows 95 and NT
*    Addressbooks, and import/export options
*    Extensions, LDAP Lookup Services
*    MAPI support modules
*    Miscellaneous goodies



Bug Fixes in v3.01d

*    A problem where space calculations were incorrectly done when saving preferences has been fixed.

*    The "Toggle monospace view" command (<F12>) in the message reader now works again.

*    A problem with identity management when sending mail using the built-in SMTP transport has been 
corrected (messages composed using the <Default> identity could be sent using the wrong "From" field.

*    Several small problems associated with the "Change user" command on the "File" menu have been 
fixed.

*    A problem where the message body would be omitted when sending attachments in MHS messages 
has been fixed.

*    A couple of cosmetic changes in the presentation of the address book have been made.



New option to check all identities for POP3 mail

In v3.01c, a new option labelled When checking for mail, check for all identities has been added to the 
"Advanced configuration options" page of the "Network configuration" dialog. When this option is 
checked, clicking the "Check for POP3 Mail" button on the toolbar will cause Pegasus Mail to perform 
checks for every identity you have currently defined using the Identities option on the Tools menu. This 
provides a very quick way of checking multiple mailboxes with a single click.

You can also force Pegasus Mail v3.01c to perform this kind of "multiple identity check" even when the 
option is not selected in your preferences by holding down the <Ctrl> key as you click the button. If the 
option is currently selected in your preferences, then holding down the <Ctrl> key will force Pegasus Mail 
to check only your current identity.

Individual identities can be excluded from multiple identity checks by checking the Exclude this identity 
from multi-identity mail checks control in the same dialog. Pegasus Mail is also smart enough not to check 
for mail more than once for any given account, even if it is specified in multiple identities.



Noticeboards heavily revised

Many corrections and enhancements have been made to Pegasus Mail's Noticeboard feature. In 
particular -

* A noticeboard setup wizard now guides you through the setup process the first time you click the 
Noticeboards button, or select the Noticeboards option on the file menu.

* Noticeboards can be created and administered from within WinPMail using the new New topic and 
Current topic properties options on the Noticeboard menu.

* Notices in noticeboards can now be annotated by anyone with post rights in the noticeboard. This 
particularly handy feature allows public comments to be attached to notices.

* You can now drag messages from any folder and drop them into a noticeboard if you have post rights 
there.



Inline display of several graphic types

Pegasus Mail can now display GIF, Animated GIF, JPEG, BMP, EMF and some TIF files without needing 
an external viewer to do so. Double-clicking any graphic from these types in a multipart MIME message 
will now display it in the message reader window.



PH Directory service client module reworked

Pegasus Mail's PH directory service module has been totally rewritten, and now conforms to the draft 
specification for the PH protocol. The new module works extremely well with the Mercury PH server 
introduced in Mercury/NLM v1.43 and Mercury/32 v2.14, and boasts a powerful user interface similar to 
the LDAP directory service module.



Attachments can be deleted from Multipart messages

It is now possible to delete any section from a multipart message by right-clicking the section from the 
message reader's section list and choosing Delete section. This operation can only be performed while 
the message is still in your new mail folder.



Word-wrapping enhanced for message reader

With an increasing amount of badly-formatted mail appearing on the Internet from poor-quality mail 
clients, it has become necessary to offer multiple ways of handling very long lines in mail messages. 
WinPMail v3.01c offers two different ways of wrapping lines:

1: Reformatting: this is the option as it has appeared in previous versions. WinPMail attempts to "guess" 
how the message was intended to be laid out and reformats the data accordingly. This option is still 
usually the most generally-accurate method of presenting abberrant data.

2: Wrapping: in this new mode, long lines are simply chopped at the right margin and wrapped to a new 
line. This mode is useful for handling some special cases where the Reformatting option fails, especially 
mail where entire paragraphs are simply stored on a single line.

Both these options can be accessed using the Reader menu while reading a message.



HTML Support heavily improved

HTML is a bit of a moving target at present - it's so poorly-standardised and the quality of the HTML 
generated by some of the major products is so poor that it's difficult to see how it can ever become a 
reasonable standard for formatted mail.

Pegasus Mail v3.01c sports a heavily-redesigned HTML parser, part of an ongoing process of trying to 
accommodate as much of HTML as we can. The new version supports frames, animated gifs and some of 
the more esoteric formatting options in HTML. Under v3.01b, some syntactically incorrect messages (in 
particular a great many generated by Netscape Communicator) could cause the program to crash when 
they were read. Under v3.01c, this should no longer happen - a number of workarounds have been 
implemented to deal with the most common HTML errors we've encountered, and the parser is now much 
more forgiving.



New identity options for rules, editor and commandline

Rules: you can now create a filtering rule that sets an identity. This is useful if you need to send a reply to 
an automatically-filtered message which uses an identity other than your default identity. The change of 
identity lasts until rule processing completes or until another rule causes an identity change.

Editor:    you can change the identity that will be used to send a message using the new control on the 
Special view of the message editor.

Commandline:    you can now specify that WinPMail should choose a particular identity at startup using 
the new      -ID <identityname>      commandline option.



Significant performance improvements in MIME handling

V3.01c's handling of MIME messages with multiple parts should be anything up to ten times faster than in 
v3.01b and earlier, owing to changes in the way such messages are processed.



Various minor goodies

* Hyperlinks should work in HTML mail messages
* Ctrl+F3 can now be used to expand an address from the recently-used addresses list: simply type in a 
couple of characters from the address you want in the To: field of the message editor and press Ctrl+F3 to 
expand it.
* Messages containing RTF data should now print properly.
* Many windows now resize more elegantly than in previous versions
* Next, Prev and Delete buttons now work in "triangle" messages
* Folders can now be closed by pressing <Esc>



Lots of bug fixes

Many small and not-so-small fixes have been made to v3.01c; the major ones are:

* V3.01b would truncate some POP3 passwords - this is fixed in v3.01c
* The time between new mail folder updates is now correctly handled
* Filenames containing commas are now handled correctly in attachments
* Filenames can now be much longer in attachments
* Scrolling in the editor is not as lightning-fast as in v3.01b
* System-wide folders are now presented in the proper mailbox
* Messages with very long lines are now forwarded properly.
* Many other problems with very long lines have been corrected
* A problem with sorting messages in the +0000 timezone has been fixed
* Signatures are now properly restored when reopening a draft message
* Several encryption-related problems have been fixed
* Handling of low disk space conditions has been markedly improved,
    especially in POP3 downloads.
* Next and Prev buttons now work in noticeboards
* Mail can now be sorted in the POP3 selective download window.
* Problems with printer initialization have been sorted out
* [16-bit] No longer GPFs when replying to a maximized message



New editor technology

Pegasus Mail v3.0 uses a new rich text editor that supports a wide range of formatting options, including 
all the standard effects like bold, italic, coloured text, and so forth. The editor allows you to read and 
compose messages of almost any size, and provides support for reading the most common types of 
formatted e-mail - HTML, Text/Enriched, and MS-RTF. Users of earlier versions of Pegasus Mail will 
appreciate the improved word wrapping in the editor, and the fact that it is now possible to do standard 
partial selection of lines in messages.



New user interface and controls

We've invested enormous effort in making Pegasus Mail more "Windows-standard", by switching to 
standard Windows controls and tools, changing our buttons so that they "rise to the cursor", and dim 
when the window is not active and adding tooltips to buttons throughout the program. We've also added 
standard column headers in our lists, that can be clicked for sorting and dragged for resizing. The Win32 
version of Pegasus Mail now sports features specific to Windows 95 and NT 4.0, including the ability to 
place the Pegasus Mail icon in the system tray (it even flaps its wings when you get new mail!), and 
property sheet pages for preferences.



Right click menus in most major window types

Pegasus Mail adds convenient right-click menu options to most of its major window types - right-clicking 
an item in a window now usually pops up a menu containing options appropriate to that type of item. You 
can also usually select a group of items then right-click on any of them to access options for the whole 
group.

Windows that support right-click menus include the Folder Manager window, the Folder Browser window, 
the Message Editor window and the Message Reader window.



Filtering rules overhauled and improved

Pegasus Mail has had the best filtering capabilities in the industry since we introduced the concept in 
1991. Now, with v3.0, filtering goes a step further, with the ability to filter by date and message age, and 
the ability to activate a rule based on whether or not the sender of the message is a member of one of 
your distribution lists (useful for suppressing "spam" from known abusers, or for restricting access to your 
lists to members). You can also now include comments in your rule files, and the process of editing your 
rules has been extensively reworked to improve its clarity and simplicity.

Pegasus Mail's rule file format is now a simple textual format, which should make it easy for people to 
share their rule files with others, and for system administrators to create tools for easy management of 
rule sets.



New plugin layer for foldering

Under Pegasus Mail v3.0, folders are supported by plugin layers, rather than being items specfic to 
Pegasus Mail. As a result, Pegasus Mail can now potentially access mail folders of almost any type 
without the need for conversion. Initially, Pegasus Mail ships with plugins that allow it to read Pegasus 
Mail v2.x folders, and to read Unix Mailbox format folders, like those generated by programs such as 
Pine, and Eudora (the mailbox files must have the extension ".MBX" before Pegasus Mail will see them). 
A foldering plugin for IMAP4 connectivity is near completion and will be available shortly after the release 
of v3.0, and we plan to release a plugin supporting a special secure, encrypted and compressed format 
later in 1998.

If you are an existing Pegasus Mail user, Pegasus Mail v3.0 will read your v2.x folders without any effort 
on your part, and the folders will still be readable by Pegasus Mail v2.x afterwards. Similarly, if you wish, 
Pegasus Mail can read, create, and write Unix mailbox files for you too, making it easy to access your 
mail from other programs.



Hierarchical foldering completely reworked

The Folder Manager window under Pegasus Mail v3.0 is probably the most visible difference from 
previous versions. It now presents your mailbox hierarchy in a standard Windows hierarchical list. Moving 
around in the list is easier thanks to [+] boxes and the use of right and left arrows to expand or collapse a 
view. Where a tray contains a folder that has unread mail in it, that tray now displays in green to indicate 
this, even if the folder is within another tray at a lower level in the hierarchy. This makes it easy to find 
your unread mail.

You can drag your folders and trays around in the hierarchy and drop them in the places you want them to 
appear, making it easy and intuitive to create a hierarchy that suits your needs. You can now also create a 
folder any time the Folder Manager window is open simply by pressing <Ins>.

Many folders in the Folder Manager window now support right-click options to access features specific to 
them. V2.x users will appreciate that there is no longer a "Check tray list" command, because it's no 
longer ever needed.

You can also have multiple mailboxes open simultaneously in the Folder Manager window - see later for 
more information on this.



Circulation messages

Pegasus Mail v3.0 introduces a new type of message called a circulation message: in this, the message 
is sent to each addressee you select, in the order you select them, one after the other. As each 
addressee receives the message, he or she will be able to read it, then when ready, add comments and 
have the message forwarded automatically to the next person in the list. When the message leaves the 
last person on the list, it is automatically returned to the original sender with all of the comments 
conveniently laid out. The sender can opt to receive progress messages as each person receives and 
forwards the message.

As their name suggests, circulation messages are an ideal way of circulating a document or idea for 
comment. Future versions of Pegasus Mail will probably include other types of "workflow" message like 
this.

Start a circulation message by selecting Circulation message from the New message submenu of the File 
menu.



Spelling checker improved, new dictionary

The spelling checker now has an option to make it begin checking immediately, rather than waiting for you 
to click "Start check". If you don't regularly use multiple dictionaries, then you probably don't need the 
spelling checker to give you the opportunity to select dictionaries before checking, so you can check this 
control and save some time. Also, when you have Pegasus Mail set to spellcheck your mail automatically 
prior to sending, there is now an option to allow you to cancel sending the message and return to editing.

The default Pegasus Mail U.S. English dictionary has a quite limited vocabularly, and many people have 
asked for a new one. We've created a new US English dictionary for v3.0, but it's quite large and may run 
rather slower on older machines, so we decided do not include it as a standard part of the file: if you want 
the new U.S. English dictionary, retrieve the file PM3USDCT.ZIP from the site from which you downloaded 
Pegasus Mail v3.0.

The new dictionary is supplied as a standard feature on the CD-ROM shipped with manuals.



Identities support improved and built-in

Previous versions of Pegasus Mail included an extension (or plugin) called "Eve" that gave a limited 
ability to change parts of your preferences in order to simulate a different "identity". Under Pegasus Mail 
v3.0, this capability is now built-in to the program, and allows you to have an unlimited number of 
identities, each with its own complete range of settings and preferences. You can change your current 
identity as simply as selecting it from a list on the toolbar, and if you want to reply to or forward a 
message using an identity different from your current identity, then you can do so easily using the Identity 
controls in the reply and forwarding dialogs.

As an example of why you might want to use identities, imagine that you retrieve mail from two different 
POP3 service providers: under Pegasus Mail v3.0, you would simply set up an identity for each, then 
switch between them any time you wanted to retrieve or send mail using the settings for a particular 
provider. In its simplest form, an "identity" is just a way of giving a name to a particular set of preferences 
and settings.

To create or manage identities, choose Identities from the Tools menu.



Simultaneous access to multiple mailboxes

Ever wished you could access folders in someone else's mailbox or in another directory on your hard 
drive without quitting and restarting the program as that user? Under v3.0 you can. Using the Add 
mailbox... command on the Folder Manager's Folders menu, you can tell Pegasus Mail to list the folders 
in another user's mailbox or in any directory to which you have access rights. Folders found in that 
location will appear under a separate node in your folder list. Once you've mounted the mailbox, you can 
open its folders, move, view, delete or copy messages in them - in short, anything you would do with your 
own folders.

To add a mailbox to your folder list, choose Add mailbox to list... from the Folders menu while the Folder 
Manager window is the frontmost window.



Easier POP3/SMTP setup, new capabilities, dialling

Pegasus Mail v3.0 has a first time Internet Setup Wizard that guides new users through the process of 
filling in the information it needs to access POP3 and SMTP mail services. The Network configuration 
dialog has also been reorganized to make it easier and clearer.

The 32-bit version of Pegasus Mail v3.0 has support for a number of ways of controlling telephone dialling 
when you access the Internet via a modem, including support for user-defined programs, support for the 
Internet Explorer v4.x and Windows 98 dialler, and support for simple automated hangup using an 
extension called HANGUP32, by John Navas. We also include a neat application called RASDIAL95, by 
Claudio Fahey, that can be used to automate dialling and disconnection using the full Windows 95 and NT 
"RAS" subsystem.

New POP3/SMTP features in v3.0 include:
*    No longer performs a POP3 authentication before sending mail
*    User can opt to send mail before retrieving it (in the Advanced options dialog)
*    Support for the APOP authentication method for POP3

The Setup Wizard can be suppressed by system administrators if necessary using a commandline switch.



Mail queue and Message draft management reworked

Under v3.0, the Review queued mail and Open saved message options on the File menu now open a 
modeless window (one that can be left open on the desktop while you do other things). This greatly 
simplifies the process of working with mail waiting to be sent.

You can now send a message or messages in your queue at any time by clicking the Send now button; 
only the selected messages will be sent. The same applies to your draft messages - you can send them 
at any time without having to reload them into an editor and click the Send button. Messages and drafts 
can be copied directly into mail folders if you wish, and even Final form messages (messages that have 
been converted into a form suitable for actual distribution) can be easily read.



Folders, sorting and display

Under Pegasus Mail v3.0, sorting options and column widths are now remembered on a folder by folder 
basis (under previous versions there was one global setting). Sorting by date can now have timezone 
compensation turned on or off (when it is on, dates are converted to GMT before comparison and 
display).

Folders now have a Size column, and messages can be sorted by size.

You can now sort in ascending or descending order by repeatedly clicking the column heading control by 
which you want to sort. Any field can now be used for ascending or descending sort.

A new Sort by thread option is available on the Folder menu: when this is selected, the folder is sorted by 
subject, then sub-sorted again by reverse date. This attempts to present related messages in the order 
they were sent.

More "From" and "Subject" data is now displayable in folders, and you can usually edit the text displayed 
in these fields using the Properties option on the folder's right-click menu.

Messages can now be marked Read-only, meaning that they cannot be moved or deleted. Use the option 
on the right-click menu for this.



Reading mail, HTML, RTF, Annotations

Pegasus Mail v3.0 uses a new editor technology to display messages when you read them: this new 
techology allows it to display four distinct types of mail message:

Standard Internet text:  still the best and easiest, really
Text/Enriched:    a special format related to the MIME specification, supporting simple formatting, such as 
bold, italics, font changes and so on.
HTML:    Pegasus Mail has reasonable support for HTML mail, although it currently does not support 
frames or animated GIFs (both will be present in the next release). HTML is often poorly implemented, so 
results with HTML mail may be variable. Pegasus Mail still gives you the option to use your web browser 
to display HTML data if you wish, but the default is to use its inline display mode. Replying to HTML mail 
may produce mixed results.
RTF:    A non-standard option, Pegasus Mail has full support for the Microsoft RTF specification. By 
default now, Pegasus Mail always sends local mail (mail to other users on your system) using RTF 
formatting, since it supports the richest variety of formatting.

You can now suppress the "footer" printed at the bottom of mail messages using the option in the print 
dialog when you print your mail.

Message annotations are now easily accessible while you read your messages.



New options for sending mail

Many new options are present affecting the way mail is sent. In the descriptions below, the text in square 
brackets describes the preferences page where the option is found.

You can now opt to suppress the "information" sections Pegasus Mail adds to describe any attachments 
your messages may have. You can also opt to suppress BCC listings in the messages you send [ Both in 
Tools | Options | Sending mail ]

You can now opt to have the reply address settings in the reply dialog reset before each message, which 
makes it more useful in some environments [ Tools | Options | Message settings ]

The Attachments view of the message editor now has a Size column, and the columns can be resized. 
This view also has a "recently-attached files" button you can use for regularly-attached files.

RTF support: you can now paste pictures and other data into messages sent to other users on your local 
system (see the right-click menu for pasting pictures).



Lists, selection and the Intellimouse

Pegasus Mail's selection within lists has been modified to conform to "Windows standards". Holding down 
Ctrl and using the arrow keys will move the selection rectangle around, and pressing <Space> will select 
and unselect items in the list. Use <Shift> + the arrow keys to select a range of items in a list.

Pegasus Mail's list views now all support live scrolling - that is, they scroll while you drag the thumb on 
the scroll bar.

Pegasus Mail now supports the Microsoft Intellimouse mouse wheel in lists and editor windows.



Configurable toolbar, and toolbar options

Pegasus Mail v3.0 has a configurable toolbar. Three standard configurations are included (see the 
Toolbars (Win32) or Button panel (Win16) preferences page), but any layout you wish can be created by 
editing a simple text file. See the file BPANEL.TXT in the RESOURCE subdirectory of your v3.0 installation 
directory for more information on customizing your toolbar. A user interface for customizing the toolbar will 
be included in a future version.

Toolbar tooltips can be turned on and off using a simple preferences option. Separate settings are 
available for controlling tooltips in the main toolbar and in the toolbars used by the major window types in 
Pegasus Mail (see the preferences page for more on this).

The formatting toolbar in the message editor can be turned on and off (see the Message editor settings 
preferences page for this).



Features specific to Windows 95 and NT

The following features appear only in the Win32 version of Pegasus Mail v3.0, which will now only run 
under Windows 95 or later, or Windows NT 4.0 or later.

Automatic timezone determination: Pegasus Mail will get the correct timezone for your mail from the 
operating system, including allowances for daylight savings where applicable (this can be controlled via a 
checkbox on the Advanced preferences page).

System tray options:    Pegasus Mail can place an icon in the system tray, and can optionally animate that 
icon (make it flap its wings) when new mail arrives. See the Advanced preferences page for these 
controls.

Dialling:    The Win32 version of Pegasus Mail has a number of options available for controlling dialup 
TCP/IP connections. Click the Dialling button in the Network configuration preferences dialog for more on 
this.



Addressbooks, and import/export options

Under Pegasus Mail v3.0, all addressbooks remember their sort order, column width, and alias resolution 
settings on a case-by-case basis - even system-wide address books.

You can now also import and export tab-delimited text files: this format is easy to work with and allows 
your addressbooks to work easily with databases and programs such as Excel. For more information on 
the tab delimited format, see the addressbook help section within Pegasus Mail. Import and export 
options appear on the Addressbooks menu.



Extensions, LDAP Lookup Services

All the standard extensions supplied with previous versions of Pegasus Mail (telephone message, mail 
merge, MultiPOP, finger, and ph client) have been updated to the new v3.0 look and feel. Some, like the 
telephone message extension, have had functionality added.

Pegasus Mail v3.0 also includes an LDAP extension: LDAP is a directory protocol that is becoming more 
and more widely-used on the Internet. All standard LDAP lookups can be performed easily with the 
Pegasus Mail LDAP extension.

Extensions can now install themselves onto the standard program menus, so the telephone message 
extension now appears on the New message submenu of the File menu, where you would expect it to be, 
while the LDAP extension appears in the Addresses menu, along with the finger and ph clients.



MAPI support modules

Pegasus Mail v3.0 includes modules that provide support for the so-called "MAPI Specification", a 
Microsoft interface that supposedly allows applications like word processors to send mail. The modules 
supplied with v3.0 currently only provide support for sending messages, not for addressbook lookups or 
receiving incoming mail.

Two different versions of the MAPI specification exist - the older "Simple MAPI" specification which is 
used by almost everyone except Microsoft, and "MAPI 1.0", a recent renovation of the MAPI specification 
that is reasonably specific to Microsoft products. Pegasus Mail v3.0 supports both specifications, although 
the MAPI 1.0 modules require more effort to use than their Simple MAPI counterparts. In order to use the 
MAPI 1.0 modules, you must have installed the Windows Messaging component, and you will need to 
add the Pegasus Mail delivery transport to your messaging profile. Note that if you have installed 
Microsoft Outlook, then that product interferes heavily with the MAPI interface under Windows, and may 
prevent other transports from being added to the Windows Messaging subsystem.

The MAPI support is provided as a separate installer that will appear in your program group after you 
have installed Pegasus Mail v3.0.



Miscellaneous goodies

* Copies to self now indicate whether or not confirmation of reading or confirmation of delivery was 
requested for the message.
* You can now set a permanent BCC address that is applied to all your outgoing messages - see the 
Sending mail preferences page for this option.
* Most dialogs and windows in the program now remember their position and size
* While reading a message, you can select an address in the message then add it to a distribution list by 
right-clicking and choosing "Add selection to DList". This is particularly useful in conjunction with the new 
filtering trigger that checks for list membership.
* The global folder search (choose Find from the Edit menu while the Folder Manager window is 
frontmost) can now search all the folders in a sub-portion of your hierarchy: simply click on a tray before 
initiating the search and all the folders in and below that tray in your tree will be searched.
* If you use Mercury as a mail gateway, you can now edit and manage your Mercury automatic reply from 
within Pegasus Mail - choose Automatic reply... from the Tools menu.
* You can set whitespace borders around the message editor, and change the way the cursor is placed in 
replies using the Message settings preferences page.
* Dragging a group from the local user list window (NetWare mode) and dropping it onto a multiline editor 
will expand the group membership for you. This is handy if you want to create a distribution list containing 
all but a few of the members of an existing group.
* Low disk space conditions are now handled much better than in previous versions.



Support for the IMAP4 protocol

Pegasus Mail now has comprehensive support for the IMAP4 protocol. IMAP4 allows you to access mail 
folders on a remote computer system as if they were on your local machine.

Pegasus Mail allows you to create an unlimited number of IMAP profiles and to access as many of them 
as you need at any time. It is possible to have multiple IMAP mailboxes online at the same time and 
drag/drop messages between them. An IMAP folder behaves exactly like a regular Pegasus Mail folder in 
any way - it can be searched, filtering rules can be applied to it and so on.

To access Pegasus Mail's IMAP features, see the IMAP profiles option on the Tools menu.



Attaching identities to folders

Starting with v3.10, you can now "attach" an identity to any folder or mailbox by right-clicking on that item 
in the Folder Manager window list.

When a folder has an identity attached to it, that identity will be the default identity when you reply to any 
messages in that folder. This allows you to specify different message settings (such as signatures and 
encryption) depending on the source of the message.

This feature is likely to be particularly useful to people who use multiple IMAP servers.



Attaching filtering rule sets to folders

Starting with v3.10, you can now "attach" mail filtering rule sets to any folder by right-clicking on that 
folder in the Folder Manager window list.

You can attach either a filtering rule set that is applied each time the folder is opened, or a set that is 
applied each time the folder is closed, or both, or neither. Any rule set created using the Create/edit 
general rule set menu option on the Filtering rules section of the Tools menu can be attached to a folder. 
You can attach the same rule set to multiple folders if you wish.



Spelling checker improvements

The v3.10 spelling checker now handles hyphenated words correctly and deals better with some common 
Internet conventions, such as enclosing a word in * characters for emphasis. It should also work 
substantially faster than in previous versions, and should offer a better selection of suggestions for 
misspellings.



Mounted mailboxes remembered between sessions

Starting with v3.10, an mailbox you have added to your folder list using the Add mailbox to list command 
on the Folders menu will be remembered and automatically remounted the next time you run Pegasus 
Mail.

For this to work correctly, you must have checked Save desktop state between sessions in the General 
preferences page of the Options choice on the Tools menu, and the mailbox must be showing in the list 
when you exit from the program (if you have removed the mailbox using the right-click Disconnect this 
mailbox option, it will not reappear in the next session).

Mailboxes mounted from floppy diskettes are not remembered between sessions.

You can now also remove any mailbox you have added in this way by right-clicking it and choosing 
Disconnect this mailbox.



Message Templates (user-programmable forms)

Pegasus Mail v3.10 includes a powerful new scripting tool that allows you to build your own mail message 
forms and templates. You can use this feature to create custom message editors, or to auto-generate 
complex replies.

Message Templates used for creating new mail messages are accessed by choosing Templates... from 
the New Message submenu of the File menu, or by pressing <Shift+F7> at any time.

To reply to a message using a template, hold down the <Shift> key as you press <R>, or as you click 
the Reply button.

Pegasus Mail ships with a couple of handy message composition templates, but has no built-in reply 
templates. For information on developing your own templates (which you can do easily with no more 
powerful tool than the simple Windows NOTEPAD applet), please see the file called TEMPLATE.TXT in the 
RESOURCE subdirectory of the directory where you installed Pegasus Mail.



Address completion

Starting with v3.10, Pegasus Mail can "complete" your addresses for you as you type them in. It 
compares what you have typed with addresses to which you have sent messages recently, and those 
contained in your addressbooks. If it finds a match, it "completes" the address for you; by typing more 
characters from the address you want to use, you can narrow in on the item you need. This feature is also 
commonly found in Web browsers, such as MSIE and Netscape.

Address completion is turned on by default for new users. Existing users can turn it on using the options 
on the Message Settings preferences page (select the Tools menu, then Options to access this page).



Resending your copies to self

You can now select any copy-to-self message (a copy of a message you have sent out), right-click it and 
choose "Resend..." from the popup menu: Pegasus Mail will create a new message editor window set up 
as closely as possible to the way the message was when you sent it out. Any attachments the original 
message had will be re-attached if the files still exist, and all the message settings used in the message 
will be restored. You can make any changes you wish to the message before sending it again.

Allied to this new feature is a number of improvements in the way Pegasus Mail saves your copies to self 
- they contain much more information and are a much better representation of what you actually sent than 
in previous versions of the program.



Many bug fixes, workarounds and corrections

* The Attachments view of the message editor has been redesigned to make it simpler to use
* The standard Windows "File Save" and "File Open" dialogs are now used everywhere
* The Ctrl+J editor reformat command now "flows on" through a message if pressed repeatedly.
* Sorting by thread in folders has been extensively tidied up
* Forwarding options have been tidied up
* Hyperlink parsing has been tidied up
* The folder hierarchy has been made much more robust than in previous versions
* The telltale window should now report mail more accurately



New Select option in folders

A new option on the Folder menu, Select, allows you to set up complex criteria for selecting messages in 
a folder based on any of a number of their characteristics. You can either mark the selected messages 
(very handy for moving them or copying them), or you can group them together at the top of your folder, 
where they will sort within their grouping according to your current sorting mode. This latter option is 
enormously handy if you just want to work with a subset of the messages in a folder.

You can also access this option by pressing Ctrl+F9 while the folder is open.



New System Messages window

Pegasus Mail v3.12 now has a new window available on its Window menu - System Messages. The 
program reports a considerable amount of information in this window - information that is useful, but 
which you don't necessarily want cluttering up your screen all the time.

Things of particular interest reported in the new window include:
* Mail messages left on the POP3 server because they are too large
* Messages sent
* Comprehensive filtering results are reported

The system messages window is configured and controlled on the new Reporting preferences page 
within the program.



New mail reporting code completely reworked

Pegasus Mail v3.12 has completely rewritten new mail reporting code. Options for reporting are now on 
their own preferences page, Reporting.

The Pegasus Mail telltale window now reports how many messages you have in your new mail folder, the 
new mail folder of any other mailbox you have mounted, the new mail folder on any IMAP connection you 
have made, and new mail held on your POP3 server when you have told Pegasus Mail to count POP3 
mail only instead of downloading automatically. The telltale window also only opens now when it actually 
has something to report. If you have previously turned off the telltale window in earlier versions because 
you found it intrusive, we suggest you try it again - in its new form, it's extremely useful.

For the Win32 version of Pegasus Mail, you can also have the system tray icon appearing all the time, 
and you can hide the Pegasus Mail taskbar icon when the program is minimized.

Finally, Pegasus Mail's new mail reporting logic now works all the time, not just when the program is 
minimized.



Changes to mail filtering rules

Pegasus Mail v3.12 now supports two new rule actions:

* Logical AND  This rule action can be used to tie several rules together, ensuring that the action in the 
final rule is executed only if all the conditions are true.

* Mark as significant  When messages are marked as significant, they sort above all other messages in 
the folder, regardless of the current sorting mechanism. This is an extremely useful way of tagging 
messages so that they come more readily to your attention.



Support for sending via Authenticated SMTP

Pegasus Mail v3.12 now supports recent Internet standards for the transmission of mail via Authenticated 
SMTP. The options controlling this appear on the Sending via SMTP preferences page in the new Internet 
Options dialog on the Tools menu.

Your ISP will be able to tell you whether or not you need to use authenticated SMTP to send mail, and if 
you do, will be able to tell you what username and password you should use.



Changes and fixes to Templates

* You can now specify an identity for a message sent using a template, using the new Set Identity = xxx 
statement in your template file.

* You can now chain templates together using a Chain command: when a template is executed that 
contains a CHAIN command, it will automatically execute the specified template when it completes 
normally.

* Attach statements now work in templates when you do not specify that the message should be opened 
in a window.



Many bug fixes and minor additions

* You can now start Pegasus Mail minimized from the startup folder reliably
* The Internet MIME "message/rfc822" content type is now properly supported
* Hyperlinks now work correctly in all messages
* You can now specify the right margin for wrapping in the message reader
* You can now hide the Pegasus Mail taskbar icon when the program is minimized.
* You can now use Ctrl+[Plus] and Ctrl+[Minus] to control the width of the columns in the folder window.
* A problem in v3.11 where adding a second attachment to a message could cause a crash has been 
fixed.
* Several improvements have been made to the way WinPMail interoperates with the DOS version of 
Pegasus Mail when they are both run on the same account.
* Fixes several problems in the way messages were forwarded in v3.11
* Stores passwords much more securely than previous versions.



Bug fixes in v3.12b

* A Y2K problem in rule sets that match on message date has been fixed.
* Problems with temporary files not being deleted have been corrected
* The Internet Setup Wizard now accepts POP3 usernames containing '@'
* The "Deleted messages" folder now properly remembers its position and size
    between sessions, and can have identities and filtering rule sets attached
    to it.
* Problems caused by folder entries not being deleted from STATE.PMJ when
    folders were deleted have been fixed.
* Problems with the "From" field in some copies-to-self have been fixed.

There was also one very small feature addition: a new template command has been added that allows 
you to control the default state of the "Send message without opening an editor" control - please see 
TEMPLATE.TXT for more information.




